
 
 

 

 

 

 

 

 

 

 

 

 

 

PL-U4101C1 PcWaveForm 

取扱説明書 基礎編 
 

2018 年 2 月 
 

Revision 3.12 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

お断り 
記載されている会社名および製品名はその会社の所有する商標です。  

記載された内容については事前のお断りなく変更させていただく場合がございます。 

 記載された内容は 2018 年 2 月現在のものです。  

ご使用にあたっては、本取扱説明書の内容を十分お読みいただけますようお願い申し上げます。 

 

本取扱説明書は、PDF 形式でプログラム CD の中に入っています。 

 
 

株式会社 デイシー 
〒198-0024 

東京都青梅市新町 9-2190 

電話: 0428-34-9860 
メール: info@deicy.co.jp 
© Copyright 2006- DEICY Corporation 

 

PL-U4101C1_PcWaveForm_InstructionManual_Basics_J 

mailto:info@deicy.co.jp


この度は、PL-U4101C1 PcWaveForm をお買い上げ頂きましてありがとうございました。 本プログラムは、当社レコーダで収録さ

れたデータファイル(収録条件などが記録されたテキストベースのヘッダファイルとバイナ リデータファイルがペアで構成される)

の波形表示や解析を行うためのプログラムです。 
 

改定履歴 
発行日 Revision 内容 

2006 年８月 26 日 3.00 改定初版 

プログラムバージョン 6.21 に合わせて全面改訂。基礎編および解析機能操作編の分冊形式に。 

2006 年 11 月 12 日 3.01 プログラムバージョン 6.21.15 以降に対応。 

CommonWave での表示オフセット機能、表示スケール情報の名前保存機能、演算機能の強化など 

2007 年１月 20 日 3.02 プログラムバージョン 6.23.XX に対応。 

2007 年３月 20 日 3.03 プログラムバージョン 6.24.XX/6.25.00 に対応。 

2007 年７月 25 日 3.04 プログラムバージョン 6.25.0.1 に対応。 

2007 年 12 月 31 日 3.05 プログラムバージョン  6.28.0.0 に対応。 

2008 年８月 26 日 3.07 プログラムバージョン  6.31.X.X に対応。 

「２．３．２． ファイルを開くときの初期表示設定オプション」記述追加。 

2008 年 12 月 22 日 3.08 プログラムバージョン 6.33.XX に対応。 

「１．３． 特長」「５．１．１． ヘッダファイル形式」に FLOAT のデータが扱えることになった記述を追加。 

「２．３．４．３． X 軸表示範囲を明示的に設定する」に圧縮表示時のカーソル位置読み取りオプション選択に 

CURRENT の記述を追加。 

2009 年 4 月 1 日 3.09 プログラムバージョン 6.34.XX に対応。 
「２．３．３．２． 波形表示画面での Y 軸スケール設定操作」 CommonWave に「表示先グリッド番号自動割り 

付け機能」に関する記述を追加。 

2009 年 11 月 1 日 3.10 プログラムバージョン 7.00.XX に対応 

WFScpipt に関する記述を追加。 

2015 年 6 月 29 日 3.11 プログラムバージョン 8.00 に対応 

2018 年 2 月 9 日 3.12 プログラムバージョン 8.11 で追加された手書き Window の表示色変更を記述追加 

 

本プログラムの取扱説明書は、 

 基礎編(本書) 

 解析機能操作編 

 Archi_1 Script 演算関数仕様編 

 Archi_1 Script 言語仕様編 

 Archi_1 Script 記述方法編 

の 5 部構成となっています。 
本、基礎編ではプログラムをご使用いただくための基礎的な内容、ファイルを開くときの初期設定、グラフスケールの設定、切り出し操作、フ 
ァイルマージなどのファイル操作、それに統計処理やレポート作成などの基礎的なデータ処理機能について説明します。 

 
ご注意 

 本書は万全を記して作成しておりますが、万一ご不明なことや誤りなどお気づきのことがありましたらご連絡下さい。 

 

 本書の実行結果から生じるお客様の損害や不利益については、それが直接的、あるいは間接的を問わず株式会社デイシー(以下、 

当社といいます)は一切の責任を負いかねますのでご了承下さい。 
 

 本書は、改良のため予告なしに変更する場合があります。 
 

 本書の一部または全部を無断で複写または転載することは禁止されています。 
 

 本書に記載された会社名や製品名は、各社の登録商標である場合がございます。 
 

安全にお使いいただくために 

 正しく安全にお使いいただくため、ご使用の前に必ず本取扱説明書を良くお読み下さい。 



ソフトウェア使用許諾契約 
お客様へ: ご使用になられる前に、本許諾内容をよくお読み下さい。本ソフトウェアは、お客様が以下のソフトウェア使用許諾契約の 

条件に同意されることを前提として、ご使用を許諾するものです。万一、同意頂けない場合は、パッケージすべてをご購入店へご返却 

下さい。ご購入代金を返金させて頂きます。 

 

本契約は、お客様が本ソフトウェアをコピー、またはインストールを開始したときから発効します。ご同意頂けない場合は、コピーや 

インストールはしないで下さい。 
 

使用権 

本使用許諾契約は、お客様が１台のコンピュータ上で、本ソフトウェアを使用する権利を許諾します。2 台以上のコンピュータ上で同 

時に使用することはできません。そのような必要がある場合は別途ライセンス契約が必要です。 
 

著作権 お客様が本ソフトウェアを取得されたことは、本許諾契約に規定された以外に本ソフトウェアのいかなる権利、権限若しくは

利権の取 得を意味するものではありません。当社はお客様に対して本ソフトウェアに関するいかなる権利も譲渡しません。本ソフト

ウェアの著 作権、その他の一切の知的財産権は、日本国憲法、万国著作権条約に基づき保護されます。本ソフトウェアの著作権、そ

の他の一切の 知的財産権、および所有権は当社またはおよびそのサプライヤに帰属しています。 

 

制限事項 お客様は、本ソフトウェアの一部またはすべてを許諾無く複製することはできません。ただし、保管目的以外で使用しない

ことを前提 に、バックアップコピーを作成することができます。また、下記の BSD ライセンス適用部分は除かれます。 お客様は、

当社の文書による事前の承諾なく、本ソフトウェアの全部又は一部に対して改修、変更、翻案、併合、逆コンパイル、リバ ースエン

ジニアリングを行ってはなりません。 

お客様は、著作権表示を削除、隠蔽などの視認困難な状態にしてはなりません。 お客様は、当社の文書による事前の承諾なく、本ソ

フトウェアの全部又は一部を譲渡・販売・転貸・リースしあるいはその二次的著作 物を創作・譲渡・販売・転貸・リースを行っては

なりません。 

 

限定的保証 当社は、本ソフトウェアの使用が許諾されたお客様に対して、推奨されたオペレーティングシステムおよびハードウェア

環境で使用さ れた場合に、本ソフトウェアが、実質的に取扱説明書どおりに機能することを、本ソフトウェアの受領後 90 日間保証し

ます。本ソフト ウェアが、取扱説明書どおりに機能しない場合においても、それが重要な差異で無い限り、保証を受ける義務は発生し

ません。本ソフ トウェアが実質的に取扱説明書に従って機能しない場合の、当社および関連会社のすべての責任並びにお客様に対する

唯一の救済手段 は、当社の選択により、本ソフトウェアの交換、または、お客様が支払った使用許諾料の払い戻しのいずれかに限られ

ます。当社は、 本ソフトウェアの使用や使用不能から生じた派生的ないかなる損害（事業上の損失、営業の中断、営業上の情報の損失、

その他の金銭 上の損害など）についても、その損害の可能性が明示であると黙示であるとを問わず当社に知らされていたとしても、責

任を負いませ ん。なお、上記は本ソフトウェアの操作が中断しないことや誤りのないことを保証するものではありません。 

 

BSD ライセンスに関する事項 
本ソフトウェアでは、BSD ライセンスで使用と再頒布が認められた、下記の著作権者のソフトウェア製品を音声再生のために使用して 

います。該当ソフトウェア製品に関するライセンス条項は以下のようになっています。原文の情報を正しく伝えるために英文のままで 

記載します。 

 

Copyright (c) 2002, Xiph.org Foundation 

 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 

conditions are met: 
 

Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer 

in the documentation and/or other materials provided with the distribution. 

Neither the name of the Xiph.org Foundation nor the names of its contributors may be used to endorse or promote products derived 

from this software without specific prior written permission. 
 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ̀ `AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 

BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 

SHALL THE FOUNDATION OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 

DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 

INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 

NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

本許諾契約に関し、ご不明な点等ござい

ましたら、下記宛にご連絡下さい。 〒

198-0024 

東京都青梅市新町 9-2190 

電話: 0428-34-9860 

メール: info@deicy.co.jp 

 

Copyright (c) 2015, DEICY Corporation 

All rights reserved. 
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１． プログラム概要 

ここでは、PcWaveForm プログラムの基本構成、およびプログラムをご使用いただくにあたっての環境条件について説明します。 

 

本プログラムは、当社レコーダで収録されたデータファイル (収録条件などが記録されたテキストベースのヘッダファイルとバイナリデータファイル 

がペアで構成される)の波形表示や解析を行うためのプログラムです。 

データファイルを波形表示し解析するまでの主な操作は、 
 

⇒ 収録データファイルを開く 

⇒ 解析を行いたい区間を画面から特定する 

⇒ 解析項目を選択する 

⇒ 解析結果・処理結果が表示される となっていま

す。 



１． プログラム概要 

Page 2 

 

 

 

１．１． 基本構成 

下記に、本プログラムの構成を図示します。 

 
 

 
 

１．２． 使用環境 

プログラム動作環境: 本プログラムは、Microsoft Windows 7/8 で動作します。 

 

取り扱うことのできるデータファイル: 当社レコーダで収録されたデータファイル(あるいは互換性のあるデータファイル)。収録条 

件などが記録されたテキストベースのヘッダファイルとバイナリデータファイルがペアで構成されたファイル。ファイル形式の詳細について 

は後述します。(AD コンバータや他の収録装置で収録されたテキストファイルや CSV ファイルを、別売りの PL-U4113 TxtBinConv 

プログラムでファイル変換して読み込むこともできます。データフォーマットの詳細については別途記載します。 
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１．３． 特長 

本プログラムは、大容量・多チャネルデータの高速波形表示、様々な方法での区間切り出し、実験現場でのデータ解析を目的 

とした統合型データ処理プログラムです。 
 

 100 チャネルを越えるチャネル数の表示と処理にも対応しました。 

 

 時間軸波形表示 Window として、チャネル個別に表示する Separate Wave モード、または、チャートレコーダイメー 

ジで各チャネルの描き出し位置とグリッド幅を設定して表示する Common Wave モードを選択することができます。 
 

 マークサーチ、レベルサーチなど各種データサーチ、データ切り出し機能やズーム機能をサポートしています。 

 

 波形解析 Window、基本統計量解析、FFT、1/n オクターブ解析、Waterfall グラフ、伝達特性、度数分布、X-Y 

表示など、各種解析 Window が選択できます。 
 

 チャネル間演算、110 を超える演算関数を搭載しています。 

 

 複数ファイルの縫合や、1 つのファイルの分割などのファイル操作を行うことができます。 
 

 切り出されたデータは、テキストファイル他、ファイル変換機能があります。 

 

 時間軸波形の値の自動読取・メモ書き機能があります。 
 

 データ形式として、INTEGER に加えて FLOAT も扱えるように拡張しました。 

 
 従来の Script 機能を発展させ、WFScript といたしました。 

◆  フォルダ内」のファイルの一括処理が可能となる 

◆ 解析範囲の自動検索処理が図れる 

◆  解析結果をテキスト（ｃｓｖファイル）として格納出来る 

◆  解析処理内容が可視化され、共有化が図れる 
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１．４． 操作メニューの機能概要 

PcWaveForm では、メニューバーからメニューを選択することで操作します。ここでは、各メニューの機能を説明します。 各メニューに

どのような機能が割り当てられているかを把握することで、プログラムで何ができるかを知ることができます。 なお、PcWaveForm の

主要な機能は、ツールバーに配置されたアイコンに割り当てられており、そのアイコンをクリックすることでメニュ ーを選択したことと同

様の操作ができます。 

プログラムの動作状態によっては、起動されないサブメニューがあります。 

 

１．４．１． [File]メニュー 
[File]メニューでは、収録データファイルや印刷関連の操作を行います。 

項目 内容 

Open... 波形表示を行うファイルを読み出します。 

Link Open... 同一収録条件で収録した複数のファイルを、連結処理して読み出します。 

Close 現在波形表示されているファイルを閉じます。 

Head Info... 波形表示されている収録ファイルのヘッダ情報を表示します。 

Acq.Memo... 波形表示されている収録ファイルの、日付、サンプリング周波数、データ数、収録時間、ファイルコメントなどの 

計測メモを表示します。 

Open Newest File 波形表示されている収録ファイルと同じフォルダにある、最新の日付のファイルを読み出します。 

Delete Current 波形表示されているファイルをそのファイルが保存されているフォルダから削除します。 

File Open Mode... ファイルを読み出すときのオプション設定です。 

 X 軸の初期読み出し・表示サイズを%で指定 

 Y  軸のスケール属性を指定:  オートレンジ、ヘッダファイルに記述された各チャネルの最大/最小スケー 

ル、収録された入力レンジ、または Y 軸スケールが保存されたスケールテンプレートファイルを適用 

 読み出し時、選択されたキャリブレーションファイルを適用して波形表示 

Save as MATLAB file... MATLAB ファイルへ変換します。 

Save as RPCIII-file... RPCIII ファイルへ変換します。 

Open Special Files ここに登録されている他社のデータファイルは直接読み出すことができます。 

Print... 画面印刷を行います。 

Print Preview 印刷プレビュー画面を起動します。 

Print Setup... 印刷時のプリンタセットアップを行います。 

Print All Chs... 表示されている波形全域を印刷します。 

 過去に開かれたデータファイルのヘッダファイル名を表示します。 

Exit プログラムを終了します。 

 

１．４．２． [Set]メニュー 
[Set]メニューには、表示チャネルリストの操作や、切り出し範囲の設定、X 軸/Y 軸のスケール設定などを行います。 

項目 内容 

View Channels... 表示チャネルリストを呼び出します。表示チャネルの ON/OFF、Common Wave が有効のときは描き出し位置 

とグリッドスケールの設定ができます。 

CommonWave 波形表示方法として、チャネル毎表示の Separate Wave モードと各チャネルの描き出し位置とグリッドスケール 

の指定ができる Common Wave モードを切り換えます。(チェックを付けると Common Wave モードとなります。) 

Compression... 1 ピクセルあたりに何個のデータを描画するか設定できます。ここで選択されたサイズで X 軸のグリッドあたりのス 
ケールが決まります。 また、データが圧縮表示されている場合、カーソル読み取り値を、その圧縮区間の最大

値(MAX)、最小値 (MIN)、算術平均値(MID)のどの値とするかを選択します。現在設定されている内容は画

面右下に<Cursor: XXX>という形で表示されます。 

Cut Down Set... カーソル位置を基準とした切り出しサイズ(ポイント・時間)が設定できます。 

Cut Down Enable 切り出し区間を有効とします。 

Cut Down Range Zoom In 切り出し区間をズームして表示します。(ただし、[Compression...]で、1 データ/ピクセルに設定されているときは 
この機能は無効です。 

Cut Down Save... 切り出し区間を、テキスト他のファイルとして保存します。 

File Edit Save... ファイル編集機能を呼び出します。表示されている複数のファイルの任意箇所をまとめて一つのファイルにした 

り、同じファイルの、異なった区間を別のチャネルに割り付けたファイルを生成したりするときに使用します。 

X-Y POSITION Adj.  
X Format & Precision... X 軸スケールの数値表記形式を設定します。 

Y Format & Precision... Y 軸スケールの数値表記形式を設定します。 

Next Set 波形表示内容を、次のチャネルセットに移動します。 

Before Set 現在の波形表示内容を、前のチャネルセットに戻します。 

Re_Formation Commmon Wave 表示のときに有効となり、各チャネルの表示を Y 軸方向に整列します。 
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１．４．３． [Scale]メニュー 
 

[Scale]メニューでは、表示スケール関連の操作を行います。 
 

項目 内容 

Change... Separate Wave のときに、各表示チャネルの Y 軸スケールの最大と最小を設定できます。 

Autoscale カレントに選択されたチャネル、または全チャネルの Y 軸オートレンジに設定することができます。 

X Zoom In Separate Wave のときに、切り出し有効にされた区間を Zoom します。(虫眼鏡 Window を起動します。) 

Save Scale 現在の Y 軸スケール情報をスケールテンプレートファイルに保存します。 

Load Scale 保存されたスケールテンプレートファイルを読み出し、現在の Y 軸表示に適用します。 

 

１．４．４． [Search]メニュー 
[Search]メニューでは、切り出し位置特定のため、様々なデータサーチ操作を行います。 

項目 内容 

Mark List... 収録時に記録されたマーク位置をリスト表示します。 

Pause List... 収録時に記録されたポーズ位置をリスト表示します。 

Trigger Setting... あるレベルを超えたポイントに移動するために、チャネルとトリガレベルを設定します。 

Mark Area... マークが記録された区間情報を表示するマークエリアリストを表示します。 

Pause Area... ポーズが記録された区間情報を表示するポーズエリアリストを表示します。 

Trigger Area Setting... チャネルを選択し、切り出し開始と終了ポイントのトリガレベルとトリガ方向を設定します。 

Jump Mark Mode マーク位置にカーソルを移動するモードを選択します。 

Jump Pause Mode ポーズ位置にカーソルを移動するモードを選択します。 

Jump Trigger Mode Trigger Setting で設定された位置にカーソルを移動するモードを選択します。 

Jump MarkArea Mode マークに囲まれた区間に切り出し範囲を移動します。 

Jump PauseArea Mode ポーズに囲まれた区間に切り出し範囲を移動します。 

Jump TrigArea Mode Trigger Area Setting で設定された区間に切り出し範囲を移動します。 

Go to Point... データポイントを入力して、その位置にカーソルを移動します。 

Go to Time... 時間を入力して、その位置にカーソルを移動します。 

Peak On Screen 波形表示されている範囲で、カレントチャネルのピーク値(最大値)にカーソルを移動します。 

Valley On Screen 波形表示されている範囲で、カレントチャネルのバレイ値(最小値)にカーソルを移動します。 

 

１．４．５． [Option]メニュー 

[Option]メニューでは、波形表示画面の X/Y 軸の表示属性や複数箇所同時切り出し設定操作を行います。 また、

WFScript の実行メニュー、及び Script Window への遷移を行います。 

項目 内容 

Time Display X 軸の表示スケールを時間単位とします。 

Point Display X 軸の表示スケールをデータポイント単位とします。 

Cut Down Range Display 指定された切り出し区間の開始/終了位置を画面下に表示します。 

Range On Screen Display 波形表示されている区間の開始(波形表示画面の左端)/終了(右端)位置を画面下に表示します。 

MultiCutDown 波形表示されている収録データに関して、切り出し条件を信号レベルで設定し、条件成立区間をファイル化 

することができます。収録データから複数にわたる解析有効区間を切り出すときに便利です。 

TimeCutDown 波形表示されている収録データに関して、切り出し条件を時間で設定し、条件成立区間をファイル化するこ 

とができます。収録データから複数にわたる解析有効区間を切り出すときに便利です。 

Unit Display Y 軸表示の各チャネルタイトル部に、単位を表示します。(Separate Wave のとき) 

Name Display Y 軸表示の各チャネルタイトル部に、チャネル名を表示します。(Separate Wave のとき) 

Title... 表示されるグラフタイトルを入力できます。 

Revise Enable 切り出し設定された区間の開始ポイントと終了ポイントのデータを直線で結ぶ機能を有効とします。 

Revise... 切り出し区間が指定されているとき上記の「直線で結ぶ」操作を実行します。 

Auto_Scroll Mode 指定された切り出し範囲を自動的にスクロールして表示します。 

Course Map 収録データに、南北速度チャネル、東西速度チャネルが存在する場合、そのチャネルデータを元にコース図を 

描画することができます。 

Script Execute Script 実行メニューを表示します。 

Script Edit Script 編集 Window に遷移します。 

Script Sheet Script 結果シート Window に遷移します。 

WFScript については、別冊の Script 編に記載します。 
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１．４．６． [Analyze]メニュー 
 

[Analyze]メニューでは、各種解析機能を実行します。 
 

項目 内容 

Statistics Report... 基本統計量解析を行います。 

NoteBook 基本統計量解析を行います。Statistics  Report と同等の機能を持ちますが、異なるファイル間の処理が可 

能です。 

XY Graphics... X-Y グラフを表示します。 

Statis2 演算式が登録でき、基本的な応力解析などを行うことができます。 

FFT/Ave.FFT... FFT 解析を行います。 

TRANS & COH... 伝達関数を表示します。 

Waterfall... 解析範囲として指定されたカレントチャネルの切り出し区間の FFT 結果を Water Fall 形式で表示します。 

Calc... チャネル間演算・関数演算を行うことができます。 

DrawPlot 値の自動読取が行える手書き Window を表示します。 

Sound 表示されている波形データを WAV ファイルに変換して PC のサウンドシステムで音として再生します。 

MultiDim Frequency Analysis 多次元時間率頻度、最大６軸のチャネルデータの信号レベルの分布をグラフ表示します。 

Distribution 度数分布解析結果を表示します。 

1/3 Octave 1/3 オクターブ解析を行います。 

Spike Cut スパイクノイズを除去することができます。 

Offset.ADJ 各チャネルにオフセット量の設定ができます。 

Multi Ch FFT 最大 9CH までの FFT を同時に行います。 

 

１．４．７． [Calibration]メニュー 
[Calibration]メニューでは、波形表示されているデータに対して物理量変換などのキャリブレーション操作を行います。 

項目 内容 

Exec By Template あらかじめ作成されたキャリブレーションファイルを読み出して、表示データのキャリブレーションを行いキャリブレー 

ション後のデータを表示します。 

Manual... 各チャネルに、キャリブレーションのためのスロープ係数を設定できます。 

UN.CAL 実行したキャリブレーション操作を初期化します。 

 

１．４．８． [View]メニュー 
[View]メニューでは、表示画面にツールバーやステータスバーを表示するかどうかを操作します。 

項目 内容 

Toolbar チェックを付けると画面にツールバーを表示します。 

Status Bar チェックを付けると画面にステータスバーを表示します。 

Multi Axis... 指定された切り出し区間を、最大 4 つの Y 軸スケールに割り付けて表示します。 

 

１．４．９． [Window]メニュー 
[Window]メニューでは、読み出されている複数 Window の画面上の配置を操作できます。 

項目 内容 

Cascade 複数 Window を重ねて表示します。 

Horz. Tile 複数 Window を水平方向に並べて表示します。 

Vert Tile 複数 Window を垂直方向に並べて表示します。 

Arrange Icons 極小化された Window アイコンを整列します。 

 現在読み出されている Window が表示されます。クリックすると、その Window に表示移動できます。 

 

１．４．１０． [Help]メニュー 
[Help]メニューでは、プログラムのバージョン情報を表示します。 

項目 内容 

About... プログラムのバージョン情報を表示します。 
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２． 波形表示画面の設定と操作 

ここでは、プログラムの基本操作として、メインとなる波形表示画面における操作として次の内容を説明します。 

波形表示画面は、各解析 Window に至るためのガイドとなる Window です。この Window で表示された波形データから対象の区間を切り 

出し、解析を行います。 
 

◆ プログラムのインストールと起動 

◆  波形表示を行うファイルを開く(オープンする) 

◆  波形表示画面の基本設定、表示モード、表示スケールと単位、初期表示設定オプションなど 

◆ 波形表示画面での操作 

◆  キャリブレーション機能 

◆ ファイル操作 波形切り出し操作や、波形切り出し後の様々な解析については、別

章に記載します。 
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２．１． プログラムのインストールと起動・終了 

２．１．１． プログラムのインストール 

PcWaveForm プログラムのインストーラは CD にてご提供いたしております。 

CD を PC に挿入すると、自動的に Setup プログラムが立ち上がります。 立

ち上がらない場合は、CD の中の、Setup.exe を実行して下さい。 
 

２．1．２． プログラムの起動と終了 

PcWaveForm.exe をダブルクリックして実行して下さい。この場合、直前に開かれたデータファイルを波形表示 Window に表示しま 

す。(プログラムインストール直後では、ブランク画面が表示されます。) 
 

 
プログラムを終了するには、 

波形表示 Window 右上の     をクリックするか、メニューバーの[File] -> [Exit]をクリックします。 

２．２． 波形表示を行うファイルを開く 

２．２．１． ファイル名を選択して開く 

ツールバーのアイコン、    をクリック、またはメニューバーの[File] -> [Open...]をクリックします。 

表示される<Open>ダイアログの中から、波形表示を行うファイル(デフォルトではヘッダファイル「*.hdr」または「*.a*」を表示)を選択 

します。 
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２．２．２． ディレクトリの中にある最新のファイルを開く 

直前に読み出された収録データファイルと同じディレクトリに保存されている、ファイル生成日時が最新のデータファイルを直接開くこ 

とができます。 

ツールバーのアイコン、   をクリック、またはメニューバーの[File] -> [Open Newest File]をクリックします。 

 
選択したファイルが表示されない場合は、ヘッダファイルに記述されている内容が、読み込み対象のファイルの記述形式と異なって 

いるか、または該当するデータファイル自体が存在しないことが考えられます。 
PcWaveForm で読み込み対象とするデータファイルのフォーマット仕様については後述します。 

 

２．３． メイン波形表示画面の基本設定 

収録データファイルをメインの波形表示 Window に表示するための、初期画面設定について説明します。 ファイルを開くにあたって、

波形表示モードの選択、初期設定オプション選択、Y 軸および X 軸スケールの設定を行います。 
 

２．３．１． 波形表示モードの選択 
PcWaveForm では、Separate Wave または、Common Wave のいずれかの波形表示モードを選択することができます。 

表示モードの選択は、メニューバー[Set] -> [CommonWave]で行います。[CommonWave]をチェックしない場合、Separate 

Wave モード、チェックをした場合は、Common Wave モードとなります。 

 
２．３．１．１． Separate Wave モード 

波形グラフをチャネル毎に分割して表示します。 一画

面あたり最大 16 チャネル分(左右にチャネルをオ ーバ

ーレイ)を表示します。それ以降のチャネルはペー ジを

切り換えて表示します。 

 

 

 

 

 

 

 

 

 

 

 

２．３．1．２． Common Wave モード 

複数チャネルの波形グラフを 1 枚のチャートレコーダイ 

メージのグリッド画面に表示します。各チャネルの Y 軸 

グリッドの描き出し位置と Y 軸グリッドスケールを個別 

に設定できます。表示されている以上のチャネルがあ 

る場合には、ページを切り換えて表示します。 

 

 

 

 

 

 
 

各表示モードの、具体的な操作内容は後述します。 
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２．３．２． ファイルを開くときの初期表示設定オプション 

PcWaveForm では、波形表示用ファイルを開く際に、初期表示画面に表示する X 軸範囲、Y 軸スケール表示基準の選択、キャ 

リブレーションファイルを自動的に読み込むかどうかの選択などの、初期表示設定を行うことができます。 
この機能は、[File] -> [File Open Mode..]で表示されるダイアログであらかじめ設定しておきます。 
波形表示中、このダイアログに行われた変更は、次に収録ファイルが開かれたときに適用されます。 

 

 
 

項目 内容 

Init. View Data Counts チェックを付けると、下記、いずれかにチェックマークを付けて初期表示画面に表示する X 軸(データ時間軸)範 

囲を設定可能となります。 

Pt: チェックマークを付け、ポイント数で設定します。 

% : チェックマークを付け、10%, 20%, 50%, 100%のいずれかの選択を行います。 10%とは、波形データ全体(収録

開始から終了まで)の中から、収録開始から全体の 10%のポイントのデータ を、初期表示(波形表示画面の

左端から右端まで)とします。 

データ量が多いファイルを開くときなど、部分表示を選択すると、初期の波形表示が早く起動します。 

Init Y Axis Scale 下記、いずれかにチェックマークを付けて Y 軸スケール基準を選択します。 
Auto: <Init View Data Counts>で選択されたデータ範囲の中で各チャネルの最大値と最小値を Y 軸グラフス 

ケールの最大・最小(Common Wave の場合は、絶対値最大の値を 1, 2, 5 ステップのスケールに収まるように 

設定した値が、グリッドあたりの初期値)として波形グラフを描画します。 

HDR: ヘッダファイルに、各チャネルの表示スケール、最大値・最小値が記述されている場合、そのスケールとな 

ります。（Common Wave では最大値を参照。） 

Depend Range: 各チャネルの入力レンジ+/-100%の値を Y 軸スケールの最大・最小(Common Wave の場合 

は、+100%の値が、グリッドあたりの初期値)として波形グラフを描画します。 
Scale File: ここで選択された、保存されたスケール情報ファイル(拡張子 scl、詳細は後述します)の Y 軸スケ 

ール値を各チャネルのスケールとして適用します。 

 

 
下記の Calibration が有効になった場合は、キャリブレーションテンプレートファイルに記述されているスケール情 

報が優先的に参照されます。 

MCal チェックを付けると、当社データレコーダ DR-600 シリーズで PC のハードディスクに収録されたデータファイルのヘ 
ッダファイル Ch 行に記述された MCAL の値を、スロープ値として－(マイナス)側データに対して修飾し表示しま 

す。(詳細は、DR-600 付属の DR600CTL プログラムの取扱説明書を参照して下さい。) 

Calibration チェックマークを付けて、キャリブレーションテンプレートファイルのパスを指定すると、当社の PcWaveCal プログラ 
ムや収録プログラムで生成されたキャリブレーションテンプレートファイル(*.cal)を、自動的に反映して波形表示 

を行います。 

キャリブレーションテンプレートファイルの内容と整合しないチャネルが存在した場合は、<Calibration failed! 

The unit of channel X is uncompatible!>のメッセージが表示されます。メッセージボックスの[OK]をクリックす

る と、そのチャネルはキャリブレーションが行われない形で表示されます。 

OK/Cancel OK をクリックすると、ここで設定された内容を確定します。次に開かれるファイルから設定が有効となります。 

Cancel では、ここの内容を確定せずに元に戻ります。 
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２．３．３． Y 軸表示スケールの設定 
PcWaveForm では、Y 軸スケール(縦軸)に関して、オートスケール、収録時の入力レンジに対応したスケール、ヘッダファイルに記述 

されたスケール情報(ファイルオープン時の選択のみ)、あるいはマニュアルで入力されたスケールのいずれかを選択することができます。 

いずれの場合でも、キャリブレーションテンプレートファイルが適用された場合には、キャリブレーションテンプレートファイルに記述され て

いるスケール情報に置き換わります。 

 
２．３．３．１． Y 軸スケールデータ値表示形式の設定 

波形表示画面に表示される Y 軸のデータ値(数値)の表示形式が選択できます。ここで設定された表示形式は、すべての 

Window 表示に共通で参照されます。 
データ値表示形式の設定は、メニューバーの[Set] -> [Y Format & Precision...]をクリックします。 

 
項目 内容 

Exponential format データ値を指数表記で表示します。 
下の Precision で入力された数字が正規化された仮 

数部の小数点以下桁数となります。 

Fractional format データ値を固定小数点形式小数点以下桁数指定で 

表示します。下の Precision で入力された数字が小

数 点以下桁数となります。 

Significant Format データ値を固定小数点形式全桁数指定で表示しま 
す。下の Precision で入力された数字が全桁数となり 

ます。 

Relative time format 本ダイアログでは機能しません。 

Real time format 本ダイアログでは機能しません。 

Precision 選択された表示モードに対応する桁数を入力します。 

<Example>のところに例が表示されます。 

OK/CANCEL OK をクリックすると、ここで設定された内容を確定しま 

す。 

CANCEL では、ここの内容を確定せずに元に戻りま 

す。 

 

２．３．３．２． 波形表示画面での Y 軸スケール設定操作 

波形が開かれた初期画面での Y 軸スケールは、ファイルオープンモード(「２．３．２． ファイルを開くときの初期表示設定オプション」 

参照)の、Init Y Axis Scale、または Calibration にて規定されますが、波形表示中にスケールを変更することもできます。 
 

Separate Wave モードの場合 
◆ オートスケール設定 

波形表示 Window のメニューバーから、[Scale] -> [Auto scale] -> [Current Channel]または[All channels]をクリックします。 また

は、ツールバーのアイコン、      (Current Channel)または       (All Channels)をクリックします。 現在波形表示されている区

間の最大・最小データ値に合わせて Y 軸スケールを決定します。(表示されていない部分を含む、す べてのデータ領域の最大・最

小ではありません。) 

 

ある一つのチャネルのみオートスケール表示するには、まず、チャネ 

ルタイトル部のチャネル表示をダブルクリックして、ハイライト表示と 

します(これをカレントチャネルと呼びます)。 

 

<Current Channel>または をクリックすると、そのチャネルが 

オートスケール表示となります。 
 

Ch1 をオートスケールに 

チャネルタイトル部 こ

の領域をクリックする 

と、チャネル番号がハ 

イライト表示となりカレ 

ントチャネルとして選 

択されます。 
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表示されているすべてのチャネルをオートスケール表示にするには、<All channels>または をクリックします。 
 

 

◆ マニュアルスケール設定 各チャネルにそれぞれ、手動で表示スケールの最大値・最

小値を設定できます。 メニューバーから、[Scale] -> [Change...]またはツールバーの

 をクリックします。 

 

<Scale Setting>ダイアログが表示されます。各チャネルの<Scale.Max>(=Y 軸表示スケール最大値)と<Scale.Min>(=Y 軸表示ス 

ケール最小値)に、設定したい値を入力します。 値を入力後、[OK]をクリックすると入力されたスケールが、グラフ表示に反映され

ます。 

<Scale.Max>は必ず<Scale.Min>よりも大きな値として下さい。小さな値が入力された場合は、[OK]をクリックしたときに、エラーメッ 

セージが表示されます。 

 

 

<Scale.Max>と<Scale.Min>の値のセルは、コピー&ペーストができます。 

① コピー元のセルにマウスカーソルをおき、マウス右クリックを行います。 
 

②  表示されるメニューから、[Copy(C)]をクリックして、<Scale.Max>と 

<Scale.Min>の値をコピーします。 

 

③ コピー先のセルにカーソルをおきます。 コピー先は、複数選択することがで

きます。複数選択する場合は、対象 の先頭のセル行でマウスをクリックして、

次に、PC の[Shift]キーを押しな がら、対象の最後のセルでマウスをクリックし

ます。 

 

④ コピー先のセルがハイライト表示されている状態で、マウス右クリックを 行

います。 

 

⑤ 表示されるメニューから、[Paste(P)]をクリックします。 
 

⑥ コピー元の<Scale.Max>と<Scale.Min>の値が、選択したコピー先に ペー

ストされます。 

値

の入力ができます。 ここで表示される数値の形式

は 

「２．３．３．１． Y 軸スケールデータ値表示形 式

の設定」で設定された形式です。 
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チャネルタイトル部 こ

の領域をクリックする 

と、チャネル番号がハ 

イライト表示となりカレ 

ントチャネルとして選 

択されます。 

 
 

◆ 波形表示画面での Y 軸スケール変更 
Separate Wave モードでは、各チャネルの波形を見ながら、上下矢印キー操作、またはマウス左/右ボタンクリック操作にて、Y 軸 

スケールの拡大や縮小を行うことができます。また、[Shift]キーを押しながらの操作では表示のオフセットをシフトすることもできま す。 

この機能は、カレントチャネルに対して有効です。任意の表示チ 

ャネルをカレントチャネルとするためには、チャネルタイトル部でマ 

ウスをクリックします。 

 

 

 

 

 
 

 カレントチャネルの波形表示スケールを拡大・縮小する カレントチャネルに

選択後、チャネルタイトル部にマウスカーソルを置きます。 左クリックで、スケ

ールが２倍ずつ拡大されます。 

右クリックで、スケールが 1/2 ずつ縮小されます。 

 

 カレントチャネルの波形をオフセット表示する カレントチャネルに選択後、チ

ャネルタイトル部にマウスカーソルを置きます。 [Shift]キーを押しながら左ク

リックで、+方向にオフセット表示が行われます。 [Shift]キーを押しながら右

クリックで、-方向にオフセット表示が行われます。 
 

Common Wave モードの場合 
Common Wave モードでは、各チャネルの波形をチャート紙イメージの画面に描画します。 画面

上の Y 軸に対して、各チャネルの描き出し位置と、グリッドあたりのスケールを設定します。 なお、

Y 軸グリッド数は自動的に設定されます。 

◆ Y 軸グリッドスケールの初期設定 ファイルが開かれたときの、各チャネルの初期グリッドスケール設定は、ファイルオープンモードの

<Init Y Axis Scale>の設定に依存し ます。(「２．３．２． ファイルを開くときの初期表示設定オプション」参照。) 

 

Auto: <Init View Data Counts>で選択されたデータ範囲の中で各チャネルの最大値と最小値を Y 軸グラフスケールの最大・最小 

(Common Wave の場合は、絶対値最大の値を 1, 2, 5 ステップのスケールに収まるように設定した値が、グリッドあたりの初期値)と 

して波形グラフを描画します。 

HDR: ヘッダファイルに、各チャネルの表示スケール、最大値・最小値が記述されている場合、そのスケールとなります。（Common 

Wave では最大値を参照。） 

Depend Range: 各チャネルの入力レンジ+/-100%の値を Y 軸スケールの最大・最小(Common Wave の場合は、+100%の値が、 

グリッドあたりの初期値)として波形グラフを描画します。 

Scale File: ここで選択された、保存されたスケール情報ファイル(拡張子 scl、詳細は後述します)の Y 軸スケール値を各チャネルの 

スケールとして適用します。 

グリッドあたりのスケール 

  例: 「X Axis Acc」の名 

前のついたチャネルの描 

き出し位置が「4」のグリ 

ッド 
チャネルタイトルバー: 
チャネル名 (グリッドスケール) カーソル現在値 を表

示 (チャネル名のない場合はチャネル番号) 
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◆ マニュアル Y 軸表示設定 各チャネルのグリッドスケールと描き出し位置は、それぞれ手動

で設定できます。 また、表示の On/Off や、チャネルタイトルラベルおよびグラフ線色を設定

することもできます。 メニューバーから、[Set] -> [View Channels...]またはツールバーの 

   をクリックします。 

<Select Channels to display>ダイアログが表示されます。 
 

チェックされたチャネルが波形表 

示されます。 

Grid Width: そのチャネルのグリッドあたりのスケールを

設 定します。 

 

 

 

 

 

 

 
ダブルクリックすると、<色の設定>ダイアロ 

グを表示し、色の選択ができます。チャ 

ネルタイトルバーとグラフ線色を変更しま 

す。 

 

 

ZeroP: 描き出し位置の値をここに入力され

た 値に変更します。 

 

 

 
<Current Ch Scale Visible>にチェックをつけるとカレントチャネ 

ル(チャネルタイトルバーの左にバー表示、チャネルタイトルバー 

がクリックされたチャネルがカレントチャネルとなります) に対応し 

た Y 軸スケールが波形表示画面右に表示されます。 

 

カレントチャネルを示すバー表示 

 

 

 

 

 

 

チャネルタイトルバーにカーソルを置き、右クリックすると、その チャネ

ルの波形表示が Off となります。 

再度 On にするためには、<Select Channels to display>ダイ アロ

グを開きます。 

OK: 変更された内容を確定 し

ます。 
Cancel: 変更をキャンセルし 
元に戻します。 

↑キーをクリックするごとに、カレントチャネルの Y 軸表示を 1, 2, 5 のステ 

ップで拡大します(Grid Width が小さくなります)。 

↓キーをクリックするごとに、カレントチャネルの Y 軸表示を 1, 2, 5 のステ 

ップで縮小します(Grid Width が大きくなります)。 

 
GridNo: 

そのチャネルの描き出し 位置を設定しま

す。 

GridNo./Grid Width とも変更を行う位置にカー 

ソルを置きクリック、またはダブルクリックすると数 

値入力ができます。 
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表示先グリッド番号自動割り付け機能 
 

CommonWave <Select Channels to display>ダイアログ下部の、<Auto assign GridNo.>にチェックを付け、[OK]をクリックすると、 

ON されているチャネル順に、自動的にグリッド番号を割り当てる機能です。 

チャネル表示 ON ⇒ OFF、または、OFF ⇒ ON に操作が行われると、表示 ON チャネルから、グリッド番号 1 から自動的に割り 

付けられます。 

明示的にグリッド番号を設定した場合は、設定されたグリッド番号は、他のチャネルを含めて ON/OFF 操作されない限り、設定さ 

れた番号を維持します。ただし、いったんいずれかのチャネルで表示 ON/OFF が行われ、<Auto assign GridNo.>にチェックが付けら 

れると、設定されたグリッド番号は破棄され、表示 ON チャネルから順にグリッド番号 1 から割り付けられます。 これにより、波形表

示画面の各横軸グリッドに各チャネルのデータを描画して、１画面の表示チャネル数を自動的に最大にするこ とができます。 
 

 

[OK]をクリックすると CommonWave 画面で波形を表示します。 
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２．３．３．３． Y 軸スケールタイトル表示の選択 

Separate Wave モードが選択されているとき、チャネルタイトル部に、物理量単位またはチャネル名表示の選択ができます。 

 

メニューバー [Option] で [Unit Display] にチェックを付けると、物理量 単位

を表示します。 

 

 

 

 

 

 

 

メニューバー [Option] で [Name Display] にチェックを付けると、チャネ ル名

を表示します。 

 

 

 

 

 

 

 
 

なお Common Wave モードでは、チャネルタイトルラベルにチャネル名と物 理量単位を同時に表示しますので、この設定は適用さ

れません。 

 

 

 

 

 

２．３．３．４． Y 軸スケール情報の保存 

波形表示モード(Separate Wave/Common Wave)で設定されている Y 軸スケール情報をファイルとして名前を付けて保存し、別 

の収録データファイルを読み出したときに、保存されたスケール情報を適用させることができます。 

現在表示されている Y 軸スケール情報を保存するには、メニューバー [Scale] -> [Save Scale]をクリックします。クリックすると、ファ 

イル保存ダイアログが表示され、名前を付けて現在の Y 軸スケール情報をファイル(拡張子 scl)に保存することができます。 
 

保存されたスケール情報で新たにファイルを開くには 保存されたスケール情報を適用して新たな収録データファイルを

開く場合は、[Scale] -> [Load Scale]で表示される<Open>ダイ アログで、適用するスケール情報ファイルを選択します。 

または、[File Open Mode...] -> <Init Y Axis Scale>で、<Scale File>にチェックを付け、適用するスケールファイルをここで指定して 

おきます。 

保存されたスケールファイルの情報が適用されるためには、収録データファイルの各チャネルの物理量単位が同一であることを条件 

とします。 
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２．３．４． X 軸表示スケールの設定 
メインの波形画面の X 軸は、時間、またはデータ(スキャン)ポイント数を選択し X 軸スケールとして表示できます。 

 

X 軸の表示範囲は、ファイルを開いた初期状態では、メニューバー[File] -> [File Open Mode...]で表示される<Open File Mode> 

ダイアログの< Init. View Data Counts>(「２．３．２． ファイルを開くときの初期表示設定オプション」参照)で設定されるパーセンテ 

ージが適用されますが、波形表示後、X 軸表示範囲を明示的に設定することや、波形を確認しながら表示範囲を変更すること 

もできます。 

 

２．３．４．１． X 軸スケール表示属性の設定 

X 軸を時間スケールとするか、または、データ(スキャン)ポイント数とするかの選択ができます。 時間スケールとした場合、その時間

表記形式を収録開始からの経過時間表示とするか、または、収録時刻表示とするかの選択 ができます。 
 

時間、またはデータ(スキャン)ポイント数をスケールに表示する 
最初に X 軸スケールを、時間、または、ポイント数表示とするか選択します。 

 

メニューバー [Option] で [Time Display]   にチェックを付けると、時間単位をスケールとして表示します。 
 

[Time Display]がチェックされ、後述する[X Format & Precision...]で<Fractional format>、<Precision>として[3]が選択された例 
 

 

メニューバー [Option] で [Point Display]   にチェックを付けると、データ(スキャン)ポイント数をスケールとして表示します。 

 

 

表示スケールが選択されているとき、メニューバー  [Option]で、X 軸属性として表示する内容について次の選択ができます。 
 

[Range On Screen Display]にチェックを付けると、表示内容が現在カーソル値から、波形表示範囲の開始点(表示画面の左端) 

と終了点(表示画面の右端)の値を示します。(ただし、自動的に時間表示となります。) 

後述する波形切り出し範囲が選択されているとき、[Cut Down Range Display]にチェックを付けることができます。このとき、表示 

内容は、切り出し区間の開始点と切り出し幅の値を示します。(ただし、自動的に時間表示となります。) 
 

 

時間スケールの表示形式の設定 

上記の設定で、メニューバーの[Option] -> [Time Display]にチェックされたとき、その時間表示形式を設定します。 

[X Format & Precision...]をクリックすると次のダイアログが表示されます。 
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２．３．４．２． ファイルを開いた直後の X 軸表示範囲 

<Open File Mode>ダイアログの< Init. View Data Counts>により選択できます。 このとき、収録データファイルのサイズによっては、自

動的に 1 描画ピクセルあたりに複数のデータを圧縮して表示することとなります。 カーソル値読み取り時、この時に圧縮されたデータ

の代表値として用いる値は、次の<Compression Set>ダイアログの設定が適用 されます。 

 
２．３．４．３． X 軸表示範囲を明示的に設定する 

現在の X 軸の表示幅を、1 ピクセルあたり何データを圧縮して表示するか設定することで選択できます。 メニュー

バー  [Set] -> [Compression....] をクリックするか、ツールバーにあるアイコンの、 をクリックします。 

 

項目 内容 

Exponential format 秒データ値を指数表記で表示します。 

下の Precision で入力された数字が正規化された仮 

数部の小数点以下桁数となります。 
Fractional format 秒データ値を固定小数点形式小数点以下桁数指 

定で表示します。下の Precision で入力された数字が 

小数点以下桁数となります。 

Significant Format 秒データ値を固定小数点形式全桁数指定で表示し 
ます。下の Precision で入力された数字が全桁数とな 

ります。 

Relative time format 収録開始からの経過時間を、ms を最小とした時間で 

表示します。(hh:mm:ss.XXX) 

Real time format 収録された時刻を、ms を最小として表示とします。 

(YY/MM/DD hh:mm:ss.XXX) 

Precision 選  択  さ  れ  た  表  示  モ  ー  ド     (Exponential 

format/Fractional format/Significant Format 選択 

時のみ有効)に対応する桁数を入力します。 
<Example>のところに例が表示されます。 

OK/CANCEL OK をクリックすると、ここで設定された内容を確定しま 

す。 

CANCEL では、ここの内容を確定せずに元に戻りま 

す。 

 

設定されたピクセルあたりの値で、ディビジョンあたりいくつにな る

かを計算して表示します。 
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項目 内容 

Each Pixel 描画ピクセルあたりいくつのデータを表示するか設定します。この例(100)の場合、100 データ分を 1 つのピクセル 

で表示します。ここで設定された値により、X 軸の 1 つのディビジョンがいくつに相当するかを<XDIV =>に表示し 

ます。この値は、波形表示画面左下の表示と連動します。 

その地点のカーソル値を読むとき、100 データのどの値を表示値とするかは、次の<Cursor Display Type>で選 

択します。 
Max 収録データの全体波形を 1 画面に表示するための表示データ数を自動的にセットします。 

Min 1 データ/ピクセルにセットします。 

Cursor Display Type 複数データが 1 ピクセルに表示設定されているとき、複数データのどの値をカーソル読み取り時の値として採用 

するかを選択します。 

CUR： カーソルポイントの実値を示します。カーソルがマウスで大きく移動されると、カーソル位置で圧縮表示 

されているブロックのデータの最初の値を表示します。その後、右矢印キーを押すごとに、カーソルは移動しませ 

んが、カーソル読み値は、次の値を順に表示します。左矢印キーでは、前の値を表示します。 

MID： 算術平均値をとります。 

MAX： 最大値をとります。 

MIN： 最小値をとります。 

現在、どの値が設定されているかは、波形画面右下に表示されます。 

OK/Cancel OK をクリックすると、ここで設定された内容を確定します。 

Cancel では、ここの内容を確定せずに元に戻ります。 

 

２．３．４．４． 波形表示画面での X 軸スケール変更 

各チャネルの波形を見ながら、ツールバーのアイコン、   または、   をクリックすることで、波形表示範囲の拡大(波形を 
圧縮して表示)と縮小(波形を拡大して表示)を行うことができます。 

クリックごとに、1 ピクセルあたりの表示データ数をインクリメント(表示範囲を拡大)、またはディクリメント(表示範囲を縮小)します。 

表示範囲拡大は、収録全データの波形が 1 画面で表示できるまで、表示範囲縮小は、1 データ/ピクセルまで可能です。 波形

表示範囲拡大の場合でも、1 ピクセルに表示されるデータは、その圧縮されたデータの最大値と最小値の２点で表示され、 波形

としての崩れはありません。 
 

 

ツールバーの、 をクリックすると収録全データが 1 画面で表示されます。 

 

ここをクリックすると、表示範囲が%で指定できます。 
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２．４． 波形表示画面における操作 

メインの波形表示画面は、さまざまなデータ解析を行うためのガイド Window の役目を持ち、収録された波形から解析に必要な 

部分を切り出すために用います。 
 

２．４．１． 基本操作 
Separate Wave モード波形画面の基本操作を説明します。 

 

 
 

グリッド表示の On/Off を行います。 

 
 

チャネル表示グループを降順/昇順に 移

動します。 

 
 

 

 

 

 
ドラッグすると波形表示を移動します。 

または、[Shift] + →/←キーで波形を移動表示をします。 

スクロール スクロール 

 

 

 

メニューバーの[Set] -> [View Channels...]をクリック、 

または、ツールバーアイコンの、 をクリックします。 

 

 

 

 

カレントチャネルであることを示します。 

1 画面に最大 16 チャネル分の波形を左(線色青)と右(線色緑)にチャネルタイ 

トルを表示し描画することができます。 

描画するチャネルは、メニューバーの[Set] -> [View Channels...] -> <Signal 

Name/Display Channels Setting>で選択できます。 
<Overlap>のチェックをはずすと、左側だけにチャネルタイトルを表示し  8 チャネ 
ル/画面となります。 

クリックするとチャネル番号リストが表示され、表示チ 

ャネルを変更することができます。 

総チャネル数 チ ャ ネ ル を ダ ブ ル ク リ ッ ク す る と <Signal 

Name Setting>ダイアログが表示され、そ 
のチャネルの名前の変更ができます。 

表示登録ボタン 左のリストでチャネルを選択し(複数可)、このボタンをクリックすると右の

表示リストに登録 されます。ただし、すでに右のリストで 16 チャネル選択されている場

合は、表示リストから 削除するチャネルを選択し(複数可)、[DEL]をクリックしてあらかじ

め表示チャネルを削除 

しておく必要があります。 

現在開かれているファイルのチャネルをリス ト

表示します。 

現在画面に表示されているチャネルをリス ト

表示します。 

Overlap がチェックされると、左と右にチャネルタイトル を

出してオーバラップ表示します。 
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Common Wave モード波形表示画面でも、Separate Wave モード画面とほぼ同じ操作ができます。ただし、表示チャネルの選択 

方法は異なります。 

 

き出

し位置に均等配置します。 ただし、チャネル数とグリッド数の関係から自動均等

配置ができない場合は、ク リックしても変更は行われません。 

↑キーをクリックするごとに、カレントチャネルの Y 軸表示を 1, 2, 5 のステ 

ップで拡大します(Grid Width が小さくなります)。 

↓キーをクリックするごとに、カレントチャネルの Y 軸表示を 1, 2, 5 のステ 

ップで縮小します(Grid Width が大きくなります)。 

動

できます。描き出し位置が変更されると<GrifNo.>にその位 置

が反映されます。 

チェックされたチャネルが表示されます。 

メニューバーの[Set] -> [View Channels...]をクリック、 

または、ツールバーアイコンの、 をクリックします。 

このダイアログの操作については、「２．３．３．２． 波形 

表示画面での Y 軸スケール設定操作」 「Common 

Wave の場合」を参照して下さい。 
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２．４．２． カーソル機能 
カーソル機能とは、表示中の波形データの値を読み出したり、解析対象範囲(切り出し区間)の起点を設定する機能です。 

←/→キーを押すことで、カーソル線が X 軸方向に移動できます。 

 

２．４．２．１． カーソル位置を手動で移動する 

カーソル線は、画面の 1 ピクセルごとに移動します。大きく移動する場合は、マウスでカーソル線をドラッグします。 

 

 
 

 

ここで表示される、カーソル値はメニューバー [Set] -> [Compression....] -> <Compression Set>ダイアログの<Cursor Display 

Type>で選択された値となります。(「２．３．４．３． X 軸表示範囲を明示的に設定する」参照。) ただし、表示データの圧縮が行

われず、1 データ/ピクセルで表示されている場合は、収録データ値そのものとなります。 

 
２．４．２．２．  カーソル位置を指定位置にジャンプさせる 

PcWaveForm では、カーソル線を、波形表示区間の最大値や、最小値、指定さ 

れたレベル、さらに指定データポイントや経過時間などの指定位置を検知して、 

自動的にカーソル線をその位置にジャンプさせることができます。 

これらの操作は、メニューバーの[Search]で行います。 

 

 

 

 

 

 

 

 

 
 

表示されている波形の最大値位置にジャンプ 

カレントチャネルの最大値位置に自動的にカーソルを移動します。 カレントチャネルの指定方法については、「２．３．３．２． 

波形表示画面での Y 軸スケール設定操作」を参照して下さい。 

現在の波形表示が、圧縮表示の場合は、[Set] -> [Compression....] -> <Compression Set>ダイアログの<Cursor Display 

Type>で<MAX>を選択しておきます。 

 

メニューバーの[Search] -> [Peak On Screen]をクリック、または、ツールバーのアイコン、 をクリックします。 

カレントチャネルの最大値までカーソル線を移動します。 

カーソル線 

←/→キーで左右に移動します。 

Separate Wave モードの例 

現在のカーソル線位置の Y 軸の値が表示 

されます。 
マウスをこの部分に置くと、マウスポインタが 

矢印の形となり、カーソル線をマウスでドラ ッ

グできます。 

カーソル線 

←/→キーで左右に移動します。 

Common Wave モードの例 

マウスをこの部分に置くと、マウスポインタが 

矢印の形となり、カーソル線をマウスでドラ 
ッグできます。 

現在のカーソル線位置の Y 軸の値が表示 

されます。 
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表示されている波形の最小値位置にジャンプ 

カレントチャネルの最小値位置に自動的にカーソルを移動します。 カレントチャネルの指定方法については、「２．３．３．２． 

波形表示画面での Y 軸スケール設定操作」を参照して下さい。 

現在の波形表示が、圧縮表示の場合は、[Set] -> [Compression....] -> <Compression Set>ダイアログの<Cursor Display 

Type>で<MIN>を選択しておきます。 
 

メニューバーの[Search] -> [Valley On Screen]をクリック、または、ツールバーのアイコン、 をクリックします。 

カレントチャネルの最小値までカーソル線を移動します。 

 

表示されている波形の設定されたレベル位置にジャンプ 

選択したチャネルの設定した信号レベル位置に自動的にカーソルを移動します。 

 

メニューバーの[Search] -> [Trigger Setting....]をクリックします。 

<Trigger Setting>ダイアログが表示されます。 

対 象 と な る チ ャ ネ ル を 、 <Trigger Ch> で 選 択 し 、 <Trigger 

value>に信号レベルを入力します。(ここで表示される物理量単 

位は、チャネルが選択されると自動的にそのチャネルの物理量 

単位が表示されます。) 

 

ここで入力された信号レベルを絶対値で超えるデータ位置にジ ャンプしま

す。 設定値を超えるデータが波形表示区間にない場合、カーソル の移

動は行いません。 

 

<Trigger Setting>ダイアログに値を入力し、[OK]をクリックします。 次に、メニューバー

の[Search] の[Jump Trigger Mode]にチェックマークを付けます。 ここで、ツールバーア

イコンの、 

が有効となります。 をクリックすると、現在のカーソル位置より右の領域で設定された条件を満たす信号レベル位

置にカーソルを移動します。 

 をクリックすると、現在のカーソル位置より左の領域で設定された条件を満たす信号レベル位置にカーソルを移動します。 

設定レベルを連続して超えているような信号の場合、カーソル線は隣接位置に移動します。再び設定値を超えている地点にジャ 

ンプしたい場合は、手動でカーソル線を任意の位置に移動してから、アイコンをクリックして下さい。 

 

全データの指定データ(スキャン)ポイント数位置にジャンプ 全データを対象として、カーソ

ル線を入力されたデータ(スキャン)ポイント数位置まで移動します。 メインメニューの[Search] -> 

[Go to Point] をクリックします。 
<SEARCH POINT>ダイアログが表示されます。 
<Go to point>には現在のカーソル位置が初期値として表示さ 

れます。ここに、移動先のデータ(スキャン)ポイント数を入力しま 

す。(この例では、20000 と入力しています。この場合、20001 個 

目のデータ(スキャン)ポイント位置まで移動する設定となります。 

開始ポイントを 0 とします。) 

<FIRST>をクリックするとデータの最初のポイント数(0)が自動的 に設定されま

す。 

<LAST>をクリックするとデータの最後のポイント数が自動的に設 

定されます。 
 

[OK]をクリックするとカーソル線が設定されたデータ(スキャン)ポイント数位置に移動します。 
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全データの指定経過時間位置にジャンプ 全データを対象として、カーソル線

を入力された経過時間位置まで移動します。 メインメニューの[Search] -> [Go 

to Time...] をクリックします。 

<SEARCH TIME>ダイアログが表示されます。 

<Go to relative time>には現在のカーソル位置が初期値として 

表示されます。ここに、移動先の経過時間を秒単位で入力し 

ます。(この例では、3.500(秒)と入力しています。) 

<FIRST>をクリックするとデータの最初の経過時間(0)が自動的 に設定されま

す。 
<LAST>をクリックするとデータの最後の経過時間が自動的に設 
定されます。 [OK]をクリックするとカーソル線が設定された経過時間位置

に移動します。 

 

 
経過時間は、収録開始データ位置を 0 秒とし、データ(スキャン)位置にサンプリング周波数を掛け算した結果を示します。したがっ 

て収録データに PAUSE 操作を含んでいた場合、PAUSE 以降のデータは正確な経過時間が適用されません。 

 

MARK 位置へジャンプ 
メニューバーの[Search] の[Jump Mark Mode]にチェックマークを付けます。 ヘッダファイルにマークリストが生成されているとき

([Search] -> [Mark List...]がクリックされると記録されたマークの一覧が表示され る場合)、ツールバーアイコンの、 

が有効となります。 をクリックすると、現在のカーソル位置より右の領域に存在するマーク位置にカーソルを移動しま

す。 

 をクリックすると、現在のカーソル位置より左の領域に存在するマーク位置にカーソルを移動します。 

◆ マークリストを用いたカーソル線の移動 

メニューバーの[Search] -> [Mark List...]をクリックして、<Mark List>を表示します。 

そのファイルに、記録されているマーク位置の一覧が表示されます。 
PcWaveForm で扱えるマークには、２種類あります。 

 

: レコーダのマークボタン、あるいは PC 収録時のマークボタンクリック操作で付けられたマークを表示します。 

: 一部のレコーダ、あるいはコントロールアプリケーションが持つ音声メモ収録機能による音声メモマークを表示します。 

 

 

マーク行をダブルクリックすると、カーソル線をそのマークの位置 ま

で移動します。 現在表示区間以外にそのマーク位置がある場

合は、そのマ ーク位置をセンターとして波形画面表示を更新し

ます。 

<Memo>のセルをダブルクリックするとメモとしてテキスト 

入力ができます。入力されたテキストはヘッダファイルに 

れ

た情報でファイル保存を行うかどうか選択できます。 
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音声メモマークをダブルクリックしてカーソル線移動後、再 

度ダブルクリックを行うと、そこに記録された音声メモファイルの内 

容が PC で再生できます。再生中は右のメッセージを表示し、 

[OK]がクリックされるまで、再生を繰り返します。 

 

 
PAUSE 位置へジャンプ 
メニューバーの[Search] の[Jump Pause Mode]にチェックマークを付けます。 ヘッダファイルにポーズリストリストが生成されていると

き([Search] -> [Pause List...]がクリックされると記録されたポーズの一覧が 表示される)、ツールバーアイコンの、 

が有効となります。 をクリックすると、現在のカーソル位置より右の領域に存在するポーズ位

置にカーソルを移動します。 

 をクリックすると、現在のカーソル位置より左の領域に存在するポーズ位置にカーソルを移動します。 

◆ ポーズリストを用いたカーソル線の移動 

メニューバーの[Search] -> [Pause List...]をクリックして、<Pause List>を表示します。 

そのファイルに、記録されているポーズ位置の一覧が表示されます。 
 

 

２．４．３． ヘッダファイルの内容の表示 
メニューバーの[File] -> [Head Info...]をクリックすると、表示されている波形データのヘッダファイルの内容が表示されます。 

ポーズ行をダブルクリックすると、カーソル線をそのポーズ 

の位置まで移動します。 

現在表示区間以外にそのポーズ位置がある場合は、 

そのポーズ位置をセンターとして波形画面表示を更新 
します。 

ヘッダファイル表示を閉じるにはここを ク

リックします。 

[File] -> [Print…]で表示されているヘッダ情報をプリント 

アウトできます。 
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２．４．４． 計測メモの確認と書き込み 

メニューバーの[File] -> [Acq.Memo...]をクリックすると、<Acq. Memo>ダイアログが表示されます。 現在表示されている波形データ

の情報が表示されます。 
 

収録データファイル名、収録開始日付と時間、収録データ(スキャン)数、収録時間、データ容量、収録装置名が表示されます。 
<Comment>には、ヘッダファイルに記録されたコメントが表示されます。 このダイアログでコメントを編集または追加を行った場合は、

ヘッダファイルの Comment が一時的に書き換えられます。 波形表示を閉じるときに、変更されたヘッダファイル情報でファイルを保

存するかどうか選択できます。 

 

２．４．５． 波形グラフのプリントアウト 

表示されている波形のプリントアウト 

メニューバーの[File] -> [Print...]をクリックすると、現在表示されている波形グラフをプリントアウトすることができます。 プリンタの設

定は、[Print Setup...]で行います。また、[Print Preview]では、プリントアウトイメージをプレビューすることができます。 
  

 

プリントアウトされたグラフに任意のタイトルを付けるには、メニュ ーバー

[Option] -> [Title...]をクリックします。 初期値は、収録データファイル名とな

っています。付けたいタイ トルを入力して[OK]をクリックします。 
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開かれた収録データ上の全チャネルの波形グラフプリントアウト 
メニューバーの[File] -> [Print All Chs...]をクリックすると、<Print All Channels>ダイアログが表示されます。 現在画面上に表示

されていないチャネルのデータも含めて収録データ全チャネルの波形データのグラフをプリントアウトします。 プリンタの設定は、

[Print Setup...]で行います。また、[Print Preview]では、プリントアウトイメージをプレビューすることができます。 ただし、ここでプリ

ントアウトされる X 軸の範囲は、現在表示されている X 軸範囲となります。 
 

ページあたりにいくつの波形グラフをプリ 

ントアウトするか設定します。(1-8) 

プリントアウト時の Y 軸スケールを設定します。 

Meas-Range: 収録時の入力レンジを最大/最小スケールと し

ます。 
Auto: 最大/最小スケールをオートレンジとします。 

[Print]をクリックすると、設定されたプリンタにプ リ

ントアウトを開始します。 
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２．５． キャリブレーション機能 

キャリブレーション機能とは、収録したデータの物理量変換を行う機能です。 

PcWaveForm では、物理量変換方法として次の３つの方法をサポートしています。 
 別売りのプログラム PL-U4112 PcWaveCal キャリブレーションプログラムで生成されたキャリブレーションテンプレートファイルを 

参照する。 

 直接変換係数を入力して行う。 

 後述する演算 Window の機能を用いる。 

 

２．５．１． キャリブレーションテンプレートを参照する 

あらかじめキャリブレーションテンプレートファイルが用意されている場合、そのテンプレートファイルを収録データファイルに適用する方 

法は２つあります。 
 

ファイルが開かれたときに自動的にキャリブレーションテンプレートファイルを適用する メニューバーの

[File] -> [File Open Mode..]をクリックして表示さ れるダイアログの<Calibration>にチェックを付け、適用するキャリ 

ブレーションテンプレートファイル名およびパスを設定します。次回、 新たにファイルが開かれたとき、自動的にここで

指定されたテンプ レートファイルを適用しキャリブレーションを実行します。 

 

 

 

 

 
 

適用するキャリブレーションテンプレートファイルを明示的に選択する 波
形表示画面から、メニューバーの[Calibration] -> [Exec By Template]をクリックする

と、適用するキャリブレーションテンプレー トファイルの選択のためのダイアログが表示さ

れます。 適用するテンプレートファイルを選択し、[開く(O)]をクリックすると キャリブレー

ションを実行します。 

 

 

 

 

 

 

キャリブレーションは、キャリブレーション対象のデータファイルのチャネル番号が、キャリブレーションテンプレートファイルに存在し、キャ 

リブレーション前の単位が一致しているときに実行されます。 

符号がマイナスとなるスロープ値はサポートしていません。 
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２．５．２． キャリブレーション係数を入力する 

メニューバーの[Calibration] -> [Manual...]をクリックすると、各チャネルの現在の物理量変換係数やチャネル名、物理量単位を 

表示した<Calibration Setting>ダイアログが表示されます。 
 

 

２．５．３． キャリブレーションの取り消し 
キャリブレーション実行後、メニューバーの[Calibration] -> [UN.CAL]をクリックすると、適用されたキャリブレーションを破棄して、キ 

ャリブレーション直前の表示値に戻します。 

 

すでにキャリブレーション済みのファイルを表示した場合は、元に戻せません。 

 

２．５．４． キャリブレーションされたデータファイルを閉じる 
キャリブレーションされたファイルを、メニューバーの[File] -> [Close]をクリックして閉じるとき、 ある

いは波形表示 Window の右上の  をクリックして閉じるとき、 

キャリブレーションされた内容でヘッダファイルを書き換え、別名で保存するかどうかダイアログが表示されます。 上書きで保存を選

択した場合、該当ファイルのヘッダ情報は書き換えられ、次回ファイルが開かれたときは、キャリブレーションが行 われた状態で表示

されます。 

信号名を入力します。 

物理量単位を入力します。 

係数

として掛け算を行う値を入力します(y=ax)。 

Save このダイアログで表示されている内容を、キャリブレーションテンプレートファイルとして、ファイル名を付けて保存することができ

ま  

Read 

 

チャネルをダブルクリックすると、各チャ 

ネルの物理量変換ダイアログが表示 

されます 
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２．６． ファイル操作 

PcWaveForm では、複数のデータ収録ファイルを 1 つの連続ファイルとしてリンクしたり、別々のファイルのチャネルを選択し、1 つのフ 

ァイルにマージしたりする機能があります。 
 

２．６．１． 表示中のデータファイルを削除する 
現在表示されている収録データファイル(ヘッダファイルとバイナリデータファイルのペア)を PC のフォルダから削除することができます。 

メニューバーの[File] -> [Delete Current]をクリックします。  

削除確認のためのダイアログが表示されます。 

[はい(Y)]をクリックすると、ダイアログに表示されている名前のヘッ ダファイル・

バイナリデータファイルをフォルダから削除します。 

 

 

 

 

 
 

２．６．２． 収録データファイルの連結処理機能 

同一収録条件で収録した複数のファイルを連結処理して、1 つのファイルとすることができます。 この機能を用いれば、一定時間ご

とに生成された収録ファイルを 1 つのファイルとして処理したり、午前・午後と行われた実験ファイ 
ルを連結して処理したり、収録データファイルの中で有効部分を抜き出して生成された複数ファイルを 1 つのファイルとして処理した 
りするときに便利です。 

 

メニューバーの[File] -> [Link Open]をクリックすると、次のダイアログが表示されます。 

 

 

[OK]をクリックすると、右側に登録されたファイルの連結処理をはじめます。連結処理を終了すると、連結処理を行ったファイルを 

自動表示します。 
ファイル連結処理は、登録されたファイル名の昇順に連結します。 

連結されるファイル間の収録開始時間が、1 秒を超えて離れている場合は、元のファイルとファイルの区切りとしてポーズを、1 秒以 

内の場合は、マークを生成します。 

連結対象として登録されたファイル数 

フォルダ選択 

左側でファイルをクリックし、そのまま右側にドラッグ&ドロップします。複数行同時選択もできます。 

[Browse]で選択したフォルダ内にあるファ イ

ルをリスト表示します。 

連結対象として登録されたファイルをリスト表示します。ここに登録さ れ

たファイルを 1 つのファイルとして連結します。 
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連結されたファイルを閉じるときに、右のメッセ 

ージが表示されます。 連結されたファイルに名

前を付けて保存するた めに、[はい(Y)]をクリッ

クして下さい。 
 

連結されたファイルは、別名を付けて保存が行われるまでは、一時ファイル(waveXXX.hdr/wavXXX.dat)として扱われます。 

上のメッセージボックスで、[いいえ(N)]が選択された場合は、連結された一時ファイルは削除されますのでご注意下さい。 
 

２．６．３． 異なる収録データファイルの編集機能 
複数の収録データファイルのチャネルの任意箇所を 1 つのファイルに編集することや、同じデータファイル上の異なった区間を、それ 

ぞれチャネルを振り替えて 1 つのファイルとして編集することができます。 

改善前と改善後など異なった収録結果を、1 つのファイルにして同時解析を行うことや、同期収録された複数収録ファイルをまと め

て 1 つのファイルとして解析を行うことができます。 
 

データファイルの編集機能は、グラフ上に解析範囲が選択されていることが必要です。 

⇒ 解析範囲選択の方法については、次の第３章を参照して下さい。 複数ファイルを編集する場合は、それらのファイ

ルが同じサンプリング周波数で収録されたファイルであることが必要です。 
 

ファイルの中の特定の範囲を設定しチャネルを抜き出し、別ファイルを生成する例を示します。 

 
①  メニューバーの[File]  ->  [Open...]をクリックしてファイルを選択し開きます。次に、    をクリックして抜き出したい範囲を指 定
します。(範囲指定の方法については、第３章を参照して下さい。) 

 

② ツールバーの、 をクリックすると<File Edit Save>ダイアログを表示します。 
 

書き出すファイル名を入力します。右のボタンをクリックする 

とフォルダの選択ができます。 

必要に応じて Comment を入力します。(ヘッダファイルに反 

映されます。) 

[OK]をクリックすると、選択された区間とチャネルでファイルを生成します。 

抜き出すチャネルを左側<Source>でクリックして選択し、右側<Target>に 

ドラッグ&ドロップします。(複数チャネル可) 
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２つのファイルからそれぞれチャネルを選択し、1 つのファイルに編集する例を説明します。 

 

① 最初のファイルを開きます。 (メニューバ

ーの[File] -> [Open...]をクリック) 

 

 

 

 

 

 

 

 

 

 

 
 

② 片方のファイルを開きます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

③ メニューバーの[Window] -> [Horz Tile]をクリックして、今、 開いた２つの

波形表示を並べて表示します。 

 

 

 

 

 

 

 

 

 

 

 

 

④    をクリックしてファイル編集を行う区間を 範囲指定しま

す。 (範囲の設定操作については、第３章を参照して下さい。) 
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⑤ 範囲指定されていない波形画面のタイトルバーの部分でマ 

ウスをクリックして、マウスのフォーカスを移動します。 ツールバー

の、 をクリックして片方の波形表示も範囲指 

定を行います。 

 

 

 

 

 

 

 

 

 

 

 

⑥ ツールバーの、 をクリックすると<File Edit Save>ダイア 

ログが表示されます。 

 

後から開いたファイルのファイル情報とチャネルリストが、ダイアログ 

の左側<Source>に表示されます。 

 

 

 

 

 

 

 

 
 

⑦  編集を行いたいチャネルを左側でクリックして選択し、右側 

<Target>にドラッグ&ドロップします。 

 

 

 

 

 

 

 

 

 

 

 

 
 

⑧ 次に、<Source>の<File Name>リストから、片方のファイルを 

選択します。選択を行うと、そのファイルのチャネルリストが表示さ 

れます。 
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⑨  編集を行いたいチャネルを左側でクリックして選択し、右側 
<Target>にドラッグ&ドロップします。 この例の場合、各ファイルから選択され、

<Target>に表示されて いる４つのチャネルが 1 つのファイルに編集されます。 

 

 

 

 

 

 

 

 

 

 

 

⑩ <Target>の<File Path>に編集後のファイル名を入力し、 [OK]をクリックす

ると、ファイルの生成を行います。 
<File Path>の左のボタンをクリックすると、現在のフォルダ位置の 

確認や変更ができます。 

<Comment1>～<Comment3>は、必要に応じてコメントをテキ 

スト入力できます。これらのコメントは、編集されたファイルのヘッ 

ダ情報のキーワードとして記述されます。 

 

 

 

 

 

 
 

⑪ 生成されたファイルを開いて確認します。 
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３． 解析範囲の指定-波形の切り出し 

PcWaveForm では、波形表示画面から解析対象とする波形範囲を切り出し、その切り出された区間データに対して様々な解析を行いま 

す。ここでは、そのデータ切り出しの方法について説明します。 
 

◆ 手動で切り出し区間を設定する 

◆  切り出し開始ポイントと範囲を明示的に設定する 

◆  記録されたマークやポーズを利用して、あるいはトリガレベルを設定して切り出し区間を設定する 

◆ 波形データから複数区間を同時に切り出す 波形切り出し後の、実際

の解析操作方法については別章に記載します。 

ここで説明する例は、Separate Wave モードの例を中心として上げますが、Common Wave モードでも共通操作です。どちらかのモードで説 

明の例がサポートされていない場合は、文中に注記します。 
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３．１． 波形データの切り出し基本操作 

表示されている波形データから、解析区間を設定し、波形のズーム表示や、解析、ファイル変換を行うために、波形グラフの範囲 

を指定することを、波形の切り出しと呼びます。切り出し操作は、表示されている波形を見ながら行うことができます。 取扱説明書

で、範囲選択部分が黒く表現されている画面は、PcWaveForm7 の画面です。PcWaveForm8 では本章のように選 択範囲は青

くなります（本書では機能が変わっていない部分について旧版画面を使用しています）。 

 

３．１．１．手動で切り出し範囲を設定する 
切り出しを行いたい部分が含まれた波形を画面に表示します。 

メニューバーの[Set] -> [Cut Down Enable]をクリックするか、ツールバーの、 をクリックします。 
 

画面上に反転表示領域が表示されます。 

 

 
 

 

 

 

 

 

 

 

 
PcWaveForm7 範囲選択画面 

 

 
この反転領域が切り出し区間となります。 

PcWaveForm8 範囲選択画面 

 

切り出し区間幅を調整するには、 

① 反転領域内にマウスカーソルを移動し、PC の[Shift]キーを押しながらその位置でマウスの左ボタンをクリックします。 

 

② マウスカーソルが、   から に変わります 

③ この状態(反転領域内にカーソルを置き[Shift]キーを押しながらマウスの左ボタンをクリック)で、マウスを画面左側にドラッグす る

と、反転表示範囲右端境界線が、左に移動します。 境界線が画面の左に移動した状態で、マウスを画面右側にドラッグすると、

境界線が右に移動します。 

反転領域内にカーソルを置き[Shft]キーを押しながら マ

ウス左ボタンをクリック 
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反転領域内にカーソルを置き、左ボ タ

ンをクリック 

をクリックします。 

 
 

④ [Shift]キーとマウス左ボタン押しをやめ、カーソルを反転領域に置いて、マウス左ボタンをクリックしながら(カーソルの形が変化 し

ます)左右に移動すると反転領域全体が左右に移動します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

⑤ ③と④の操作を繰り返すことによって、切り出し範囲を反転表示で設定します。 波形データ全体を、切り出し範囲として指定

するには、   をクリックしてから、    をクリックします。 

切り出し区間の再描画 

切り出し区間を指定したとき、ツールバーの、   が有効になると、切り出し区間(現在の表示反転領域)を X 軸方向に拡大 
して再描画できることを示します。 

この拡大操作は、1 データ/ピクセルの表示(「２．３．４．３． X 軸表示範囲を明示的に設定する」参照)となるまで有効です。 拡

大後の表示を元に戻す操作はできません。 

メニューバーの[Set] -> [Cut Down Range Zoom In] 

をクリック、または、 
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３．１．２．切り出し開始ポイントと範囲を設定する 

カーソル線位置を基点として、切り出し開始ポイントを設定し、そこからの切り出し範囲を指定し切り出し区間を明示的に設定 

することができます。 

 

① 最初に、カーソル線を切り出し基点位置まで移動します。 カーソル線の移動操作

については、「２．４．２． カーソル機能」を参照して下さい。 

 

 
②  メニューバーの[Set] -> [Cut Down       をクリックすると、<Cut              Down              Set>ダイアロ グを表示します。 

 

 

③ [OK]をクリックしてダイアログを閉じます。 
 

④  メニューバーの[Set] -> [Cut Down Enable]をクリックするか、ツールバーの、 をクリックします。 
 

⑤ 設定された切り出し範囲が反転表示されます。 

 

 

３．１．３．MARK-MARK 間への切り出し区間ジャンプ 
MARK にはさまれた範囲を解析範囲としてジャンプすることができます。 

この機能は、ヘッダファイルに MARK 行が存在している時に有効で、反転表示領域を MARK-MARK 間で移動できます。 

 

メニューバー[Search] -> [Jump MarkArea Mode]をクリックしてチェックマークを付けます。 

次に、任意の位置で切り出し区間を設定します。 
ここで、ツールバーアイコンの、 が有効となります。 

をクリックすると、現在の反転表示位置より右の領域にある MARK-MARK 間に切り出し区間をジャンプします。 

 をクリックすると、現在の反転表示位置より左の領域にある MARK-MARK 間に切り出し区間をジャンプします。 

 
最初の MARK-MARK 間は、収録開始点と最初の MARK 位置となり、また最後の MARK-MARK 間は最後の MARK 位置か 

ら収録データの終わりまでとなります。 

項目 内容 

Cut Down Range Size 切り出し範囲を指定します。 

Pt 切り出し範囲を、データ(スキャン)ポイント数 
で入力します。入力後、マウスを<Sec>に移 

動すると、入力されたポイント数に対応した 

時間が<Sec>に表示されます。 

Sec 切り出し範囲を、時間(秒)で入力します。 
入力後、マウスを<Pt>に移動すると、入力さ 

れた時間に対応したデータ(スキャン)ポイント 

数が<Pt>に表示されます。 

Location By Cursor Before: 上で設定された切り出し範囲をカ 

ーソル線より前に適用します。 

Center: 上で設定された切り出し範囲をカ ー

ソル線を中心として設定します。 

After: 上で設定された切り出し範囲をカー ソ

ル線の後ろに設定します。 

OK/CANCEL OK をクリックすると、ここで設定された内容を 

確定します。 

CANCEL では、ここの内容を確定せずに元 

に戻ります。 
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◆ マークエリアリストを用いた切り出し区間のジャンプ 任意の位置で切り出し

区間を設定します。 
ここで、メニューバーの[Search] -> [Mark Area...]が有効となるので[Mark Area...]をクリックします。 

<Mark Area Selection>が表示され、そのファイルに、記録されている MARK-MARK 間の一覧が表示されます。 

ジャンプしたい MARK-MARK 間にカーソルを置き、[Jump]をクリック、またはダブルクリックすると波形グラフ上の該当部分に切り出 

し区間をジャンプします。 
 

 

３．１．４．PAUSE-PAUSE 間への切り出し区間ジャンプ 
PAUSE にはさまれた範囲を解析範囲としてジャンプすることができます。 

この機能は、ヘッダファイルに PAUSE 行が存在している時に有効で、反転表示領域を PAUSE-PAUSE 間で移動できます。 

 

メニューバー[Search] -> [Jump PauseArea Mode]をクリックしてチェックマークを付けます。 

次に、任意の位置で切り出し区間を設定します。 
ここで、ツールバーアイコンの、 が有効となります。 

をクリックすると、現在の反転表示位置より右の領域にある PAUSE-PAUSE 間に切り出し区間をジャンプします。 

 をクリックすると、現在の反転表示位置より左の領域にある PAUSE-PAUSE 間に切り出し区間をジャンプします。 

 
最初の PAUSE-PAUSE 間は、収録開始点と最初の PAUSE 位置となり、また最後の PAUSE-PAUSE 間は最後の PAUSE 

位置から収録データの終わりまでとなります。 

 

◆ マークエリアリストを用いた切り出し区間のジャンプ 任意の位置で切り出し

区間を設定します。 
ここで、メニューバーの[Search] -> [Pause Area...]が有効となるので[Pause Area...]をクリックします。 
<Pause Area Selection>が表示され、そのファイルに、記録されている PAUSE-PAUSE 間の一覧が表示されます。 ジャンプした

い PAUSE-PAUSE 間にカーソルを置き、[Jump]をクリック、またはダブルクリックすると波形グラフ上の該当部分に切り 出し区間を

ジャンプします。 
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３．１．５．トリガ成立範囲への切り出し区間ジャンプ 

収録データにトリガ値およびトリガ方向を、それぞれ始点と終点で設定し、このトリガ条件が成立した範囲(トリガエリア)に切り出し 

範囲をジャンプすることができます。 
 

①  メニューバーの[Search] -> [Trigger Area Setting...]をクリックします。 
 

②  <Trigger Area Setting>ダイアログが表示されます。 

 

 

 

 
 

<Begin>と<Until>における<Up>と<Down>の選択との関係については次のようになっています。 
 

 

 

Begin 設定レベル 

 

 

 
 

Until 設定レベル 

Down 

 

 

 
 

Up 

 

 
 

青囲み部分が切り出し範囲 

 

 

 

 

Begin 設定レベル 

 

 

 
 

Until 設定レベル 

Begin 設定レベル 

 

 

 
 

Until 設定レベル 

Down 

 

 

 
 

Down 

 

 
 

青囲み部分が切り出し範囲 青囲み部分が切り出し範囲 
 

③  メニューバー[Search] -> [Jump TrigArea Mode]をクリックしてチェックマークを付けます。 
 

④ 次に、任意の位置で切り出し区間を設定します。 ここで、

ツールバーアイコンの、 が有効となります。 

Begin を Up、Until を Down Begin を Down、Until を Up 

Begin を Up、Until を Up Begin を Down、Until を Down 

Begin 設定レベル Up 

Until 設定レベル  

 

Up 

Up 

項目 内容 

Trigger Ch トリガを掛けるチャネルを選択します。 

ここで選択するチャネルは、現在波形表示 

が行われていない同収録ファイル上のチャネ 

ルでも有効です。 
Begin トリガ切り出しの開始ポイントを設定します。 

Level トリガレベル値を入力します。 

Up/Down トリガレベルをよぎる方向を選択します。 

Until トリガ切り出しの終了ポイントを設定します。 

Level トリガレベル値を入力します。 

Up/Down トリガレベルをよぎる方向を選択します。 

OK/CANCEL OK をクリックすると、ここで設定された内容を 

確定します。 

CANCEL では、ここの内容を確定せずに元 

に戻ります。 
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をクリックすると、現在の反転表示位置より左の領域にあるトリガエリアに切り出し区間をジャンプします。 

 
 

３．１．６．切り出し区間の自動スクロール 
波形画面に表示された切り出し区間は、自動的にスクロールすることができます。この機能は後述する FFT などの解析 Window 

などを時間軸波形画面の遷移と自動連動させ表示するときに便利な機能です。 

 

まず、切り出し区間を波形画面に表示します。 

 

メニューバー[Option] -> [Auto_Scroll Mode]をクリックすると<Auto...>が表示されます。 

 

FFT Window との連動例 
 

⑤ をクリックすると、現在の反転表示位置より右の領域にあるトリガエリアに切り出し区間をジャンプします。 

さ

れている切り出し区間の幅で移動 

を開始します。 

現在反転表示位置から反転表示 

されている切り出し区間の幅で移動 

を開始します。 

移動条件を設定します。 クリックすると

<Auto_Scroll Setting>ダイア ログを表示し

ます。 移動を停止します。 

指定

します。最大は 1000 点です。 

スクロール時間間隔を指定します。 10ms から 

1000ms まで 10ms 刻みで指定します。 

切り出し区間のスクロール移動にともなって、その区間 

の FFT 波形も自動的に変化します 
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<Auto>にチェックを付けるとデータファイルの頭から分割処 

理を行います。 

分割の開始位置を入力します。 

切り出すサイズを入力します。 

分割の開 

[EXECUTE]をクリックすると、指定された条件でファイル分割を開始します。 分割されたファイル

は、元ファイルと同じフォルダに生成されます。 

の場合は、開始ポイント番号を使用します。 

こ の エ リ アは 、 分 割 開始 位 置 と サ イ ズ が 指 定 さ れ 、 

[EXECUTE]をクリックしてファイル分割が行われたときに、 

生成されたファイル名とファイルサイズが表示されます。 

 
 

 

３．２． 複数範囲自動抜き出し操作 

表示されている波形データから、ある条件に基づいて、複数の範囲を抜き出し、別ファイルとして保存することができます。 複数

範囲の抜き出し方法は、時間(またはデータ=スキャンポイント数)でファイルを分割する方法と、トリガなどの抜き出し条件を 設定

しておいて、条件が成立した範囲でファイルを生成して保存する方法があります。 
 

３．２．１．時間またはデータポイント数でファイルを分割する 

長時間連続で収録された 1 つのデータファイルを、等間隔時間、またはデータ（スキャン）ポイント数で複数ファイルに分割すること 

ができます。 

 

メニューバー[Option] -> [TimeCutDown]をクリックすると、<Condition Setting>ダイアログが表示されます。 

時間を設定して複数ファイルに分割する場合は、<Start Time>のラジオボタンをクリックします。 データ(スキャ

ン)ポイント数で複数ファイルに分割する場合は、<Start Points>のラジオボタンをクリックします。 

 

 

 

 

 

 

 

 
 

 <Repeat>にチェックを付けると設定さ 

れた分割開始位置から<Cut Down 

Size>で設定されたサイズのデータをフ 

ァイルの最後まで分割します。 

 

 

始位置を入力します。 
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３．２．２．条件成立した区間を抜き出しファイルとする 

表示されている波形に抜き出し条件を設定し条件成立区間だけを抜き出して 1 つのファイルにする機能です。 収録データから

複数の区間にまたがる解析対象部分を抜き出し、一括して解析することに利用できます。 
 

① 波形表示画面で、切り出し区間を設定します。設定された切り出し区間の中で、条件成立した範囲をファイルにします。 ファ

イル全体を抜き出しの対象範囲とするには、   をクリックしてから、    をクリックします。 

② メニューバー[Option] -> [MultiCutDown]をクリックします。([MultiCutDown]は波形画面に切り出し区間が表示されていると 

きに有効となります。) 

 

③  <Condition Setting>ダイアログが表示されます。 
 

 
④ [Create]をクリックすると、抜き出し条件設定ダイアログが表示されます。 

 

 

<Ref. Ch> で設定を行うチャネルを選択し、入力開始条件 <Begin> と終了条件 <Until>    の各パラメータを設定します。 

項目 内容 

Ref. Ch 条件設定を行うチャネルを選択します。 

選択されたチャネルのチャネル名と物理量単 

位が右側に表示されます。 
Begin 抜き出し開始モードとパラメータを設定しま 

す。選択されたモードでのパラメータ内容は 

次に述べます。 

Repeat チェックをすると、ここで設定された条件参照 
を繰り返します。 

OK/CANCEL OK をクリックすると、ここで設定された内容を 
確定します。(<Condition Setting>ダイアロ グ

に設定された条件行が追加されます。 

CANCEL では、ここの内容を確定せずに元 

に戻ります。 

 

[Browse]をクリックして指定します。 

AND: 各行の条件をすべて満足した範囲をファイルに生成します。 
OR: 各行の条件のいずれかを満足した範囲をファイルに生成します。 

SEQ: 各行の条件の成立ごとに範囲をつないで最終的に 1 つのファイルとします。 

[Create]をクリックして表示されるダイアログで設定された抜き出 し

条件を登録・表示するエリアです。 複数行の条件設定が可能で

す。 

これらのボタン操作については、順を追って説明します。 
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[UNDER] 
<Duration > 

 

[DOWN] 

 
 

<Mode>では、抜き出し条件を選択します。レベル設定[Level]、レベルクロス設定[LevelCross]、レベルエリア設定[Area]、レベ 

ル変化率設定[Level-Ratio]、パルスカウント設定[Pulse-Count]、データカウント設定[Data-Count]、MARK 設定[Mark]、 

PAUSE 設定[Pause]の８種類をサポートしています。開始モードと終了モードは、異種のモードを組み合わせて使用できます。 
 

<Mode>以下のパラメータは、選択された<Mode>によって、それぞれ必要なパラメータ設定項目が表示されます。 

 

レベル設定[Level] 

必要 なパ ラメー タ は 、 設定レ ベル <Level> 、 持 続時間 <Duration>( 秒で入力 ) 、 判 定方向 <Compare> 、 抜き 出 しポ イン トオ フセッ ト 

<Before><After>、および増減値<Step>(ただし<Repeat>がチェックされたとき)から構成されます。 
 

 
[OVER] 

 

<Level> 

 

 

 

 
 

 
Begin のとき [Before]で設定されたデータ(スキャ

ン)ポイント数 このポイントが開始ポイント成立点

となります。 

Until のとき [After]で設定されたデータ(スキャ

ン)ポイント数 このポイントが終了ポイント成立

点となります。 

 

<Ref.Ch>のデータが、<Level>を、<Compare>の方向に<Duration>の間だけ越えて維持されたときに、<Duration>時間だけさかのぼった点を成 

立点とします(ただし、<Before><After>が[0]のとき)。 
 

<Step>=増減値は、<Repeat>がチェックされているときに有効で、繰り返し判定時、次回条件判定される時に設定された<Level>値に対して 

<Step>で入力された値が加算され<Level>判定値となります。<Repeat>がチェックされていない場合は、設定された条件が一回成立すると 

<Step>は参照されず、抜き出しは 1 回のみとなります。 
 

レベルクロス設定[LevelCross] 
必要なパラメータは、設定レベル<Level> 、レベルクロス方向<Direction>、抜き出しポイントオフセット<Before><After>、および増減値 

<Step>(ただし<Repeat>がチェックされたとき)から構成されます。 
 

 

[UP] 
 

<Level> 

 

 

0 

 

 

<Direction>が[ABS]の場合は、絶対値でこの値を 

データ値が超えたとき条件を満たすことになります。 

 
 

 

 
 

Begin のとき [Before]で設定されたデータ(スキャ

ン)ポイント数 このポイントが開始ポイント成立点

となります。 

Until のとき [After]で設定されたデータ(スキャ

ン)ポイント数 このポイントが終了ポイント成立

点となります。 

 

<Ref.Ch>のデータが、<Level>を、<Direction>方向によぎった点を成立点とします(ただし、<Before><After>が[0]のとき)。 

 

<Step>=増減値は、<Repeat>がチェックされているときに有効で、繰り返し判定時、次回条件判定される時に設定された<Level>値に対して 

<Step>で入力された値が加算され<Level>判定値となります。<Repeat>がチェックされていない場合は、設定された条件が一回成立すると 

<Step>は参照されず、抜き出しは 1 回のみとなります。 

<Compare>が[OVER]のとき 
成立点 

ただし<Before>または<After>が[0]のとき 

<Direction>が[DOWN]のとき 成立点 

ただし<Before>または<After>が[0]のとき 
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レベルエリア設定[Area] 必要なパラメータは、下限設定レベル<LowerLevel>、上限設定レベル<UpperLevel>、持続時間<Duration>(秒

で入力)、範囲設定<Area>、 および抜き出しポイントオフセット<Before><After>から構成されます。 
 

Begin のとき 
[Before]で設定されたデータ(スキャン)ポイント数 

このポイントが開始ポイント成立点となります。 

 

<Area>が[IN]のとき、<Ref.Ch>のデータが、<UpperLevel><LowerLevel>および<Duration>で囲まれた範囲にあるとき、<Duration>だけさかのぼ 

った点を、成立点とします(ただし、<Before><After>が[0]のとき)。 
<Area>が[OUT]のとき、<Ref.Ch>のデータが、<UpperLevel><LowerLevel>および<Duration>で囲まれた範囲外にあるとき、<Duration>だけさ 

かのぼった点を、成立点とします(ただし、<Before><After>が[0]のとき)。 
 

レベル変化率設定[Level-Ratio] 
必要なパラメータは、閾値比率設定<Ratio>、累積か否か<Compare>、および抜き出しポイントオフセット<Before><After>から構成されます。 

 

<Ref.Ch>の 1 階差分値(⊿X)を分子に、選択された切り出し区間(解析範囲)の、最大値 Xmax - 最小値 Xmin の値を分母にした%を求め、 

設定値より大きい場合成立点とします(ただし、<Before><After>が[0]のとき)。<Compare>で[ACCUMULATE](累積設定)が設定された場合、 

不成立区間の 1 階差分値を都度加算して判定します。なお、成立した時点で、累積が解除されます。 

<Duration> 
[OUT] 

<UpperLevel> 

[IN] 

<LowerLevel> 
[OUT] 

Until のとき 
[After]で設定されたデータ(スキャン)ポイント数 

このポイントが終了ポイント成立点となります。 

<Area>が[IN]のとき 成立点 

ただし<Before>または<After>が[0]のとき 
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[DOWN] 

[UP] 

成立点 

<Counts>が[3]の例 <Direction>が[UP]のとき 

パルスカウント設定[Pulse-Count] 必要なパラメータは、パルスカウント数<Counts>、閾値<Threshold>、判定方向<Direction>、お

よび増減値<Step>(ただし<Repeat>がチェック されたとき)から構成されます。 

 

 

 

 
 

<Threshold> 

 

 

 

 

 

 
 

<Ref.Ch>のデータが、<Threshold>を、<Direction>の方向に越えて再び超えるまでを<Counts>の 1 とカウントします。<Direction>が[UP]のときは、 

<Threshold>を正方向に過ぎてから再び正方向で過ぎると 1 とカウントします。[DOWN]のときは、<Threshold>を負方向に過ぎてから再び負方 

向で過ぎると 1 とカウントします。設定された<Counts>数分を満たした点を成立点とします。 

 

<Step>=増減値は、<Repeat>がチェックされているときに有効で、繰り返し判定時、次回条件判定される時に設定された<Threshold>値に対し 

て<Step>で入力された値が加算され<Threshold>判定値となります。<Repeat>がチェックされていない場合は、設定された条件が一回成立す 

ると<Step>は参照されず、抜き出しは 1 回のみとなります。 
 

データカウント設定[Data-Count] 必要なパラメータは、データ(スキャン)カウント数<Counts>、および増減値<Step>(ただし

<Repeat>がチェックされたとき)から構成されます。 条件判定開始地点直後のデータ数が設定されたデータ(スキャン)数に達した点を成立

点とします 

 

<Step>=増減値は、<Repeat>がチェックされているときに有効で、繰り返し判定時、<Counts>を[1000]、<Step>を[100]と抜き出し終了条件 

<Until>で設定した場合は、1 回目は抜き出し開始点から 1001 点、2 回目は抜き出し開始点から 1101 点、3 回目は抜き出し開始点から 1201 

点が成立点となります。 
 

MARK 設定[Mark] 
必要なパラメータは、開始条件<Begin>で本モードが選択された場合は、Mark 番号(絶対番号)<Mark No.>とさかのぼりデータ(スキャン)ポイント 

数<Before Data>、および、加算数<Step>(ただし<Repeat>がチェックされたとき)から構成されます。 

設定された Mark 番号データ位置から、データ(スキャン)数<Before Data>で設定されたデータ(スキャン)ポイント数だけさかのぼった点が成立点と 

なります。ただし、設定されている解析範囲に当該 Mark 番号が存在しない場合は不成立となります。 
<Repeat>がチェックされている場合は、２回目の成立点は設定された Mark 番号に加算数<Step>で設定された値を加算した Mark 番号データ 

位置から<Before Data>のポイント数だけさかのぼった点が成立点となります。 

 

終了条件<Until>で本モードが選択された場合は、Mark 個数<Counts>と終了マークから後ろにどれだけ有効とするかデータ(スキャン)ポイント数 

から構成されます。 

このとき、切り出し開始点から設定されている Mark 個数<Counts>経過のデータ位置が成立点となります。 
 

Mark 14 Mark 15 Mark 16 Mark 17 Mark 18 

<Before  Data> 

<Begin>で<Mark No.>が[15]、<Before 

Data>が設定され、<Until>で<Counts> 

が[2]のとき 

<Begin>成立点 <Until>成立点 
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登録された抜き出し条件を変更するには、行をダ 

ブルクリックして抜き出し条件設定ダイアログを再 

表示します。 

ただし、設定された<Ref.Ch>の変更は できませ 

ん。 この場合は、 いったん[Delete] 操作を行い 

[Create]で新たに抜き出し条件を設定します。 

PAUSE 設定[Pause] 
必要なパラメータは、開始条件<Begin>で本モードが選択された場合は、Pause 番号(絶対番号)<Pause No.>、および、加算数<Step>(ただし 

<Repeat>がチェックされたとき)から構成されます。 

設定された Pause 番号データ位置が成立点となります。ただし、設定されている解析範囲に当該 Pause 番号が存在しない場合は不成立とな 

ります。 

<Repeat>がチェックされている場合は、２回目の成立点は設定された Pause 番号に加算数<Step>で設定された値を加算した Pause 番号デー 

タ位置が成立点となります。 
 

終了条件<Until>で本モードが選択された場合は、Pause 個数<Counts>で構成されます。 このとき、切り出し開始点から設定

されている Pause 個数<Counts>経過のデータ位置が成立点となります。 
 

⑤必要な抜き出し条件モードとパラメータを入力したら、[OK]をクリックしてダイアログを閉じます。 

 

⑥  入力された抜き出し条件が、<Condition Setting>ダイアログに登録されます。 

 

 

 

 
 

  
登録された抜き出し条件 

登録された抜き出し条件を削除するには、行をクリックしてハイライト 

表示し[Delete]をクリックします。 

  

 

 
⑦ 必要に応じて、他の抜き出し条件を設定します。複数行設定された場合、<Exec Mode>で選択された論理演算モードでフ 

ァイルを生成します。 
AND: 各行の条件をすべて満足した範囲をファイルに生成します。 

OR: 各行の条件のいずれかを満足した範囲をファイルに生成します。 

SEQ: 各行の条件の成立ごとに範囲をつないで最終的に 1 つのファイルとします。 
 

抜き出し条件の保存 設定した抜き出し条件を保存することができます。[Save]をクリックすると、ファイル保存ダイアログが表示

されます。ファイル名を設 定し、抜き出し条件ファイルとして保存できます。保存される内容は、リスト上に表示されている設定行

および論理演算モードと なります。ファイルは拡張子.cut で内部形式となります。 

 

抜き出し条件の読み出し あらかじめ保存された抜き出し条件ファイルを読み出すことができます。[Load]をクリックすると、ファ

イル読み出しダイアログが表示 されます。読み出しに際してすでに条件設定行が存在する場合、確認のダイアログが表示されま

す。 

確認ダイアログで OK を選択すると、現在表示中の内容は破棄され、読み出されたファイルの内容に置き換わります。 読み出さ

れた抜き出し条件ファイルに記載されているチャネルが存在しない場合は、「エラー」となり読み出されません。ただし、チ ャネルが

存在しているが単位あるいは信号名が異なる場合は、表示されているファイルの信号名および単位が参照されて表示さ れ、 設

定条件および条件間の論理演算設定はそのまま参照されます。 
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⑧ [Preview]をクリックすると、<Preview> Window にて抜き出し条件成立範囲を確認することができます。 
 

 

  

 
⑨ [QUIT]をクリックして<Preview>を閉じます。 

 

⑩ <Condition Setting>ダイアログで[EXEC]をクリックすると、<Output File>に入力されたファイル名でファイルを生成します。 生成

されるファイルは、元ファイルに収録されているすべてチャネルから、抜き出し条件範囲を保存するため、元データと同じチャネ ル構

成となります。 

 

MARK/PAUSE の扱いについて 

生成されるファイルには、元データファイルのヘッダファイルに記録されていた MARK 行と PAUSE 行は破棄します。 そのかわり、論

理演算モードが[AND]または[OR]のときは抜き出し開始地点を示す MARK 行を生成しヘッダファイルに書き込み ます。論理演

算モードが[SEQ]の場合は、設定条件の各行の区切りに PAUSE 行を生成しヘッダファイルに書き込みます。 

 

抜き出し生成されるファイルのデータ列の継ぎ目は不連続データとなります。抜き出された範囲ごとに処理を行う場合は、[Jump 

MarkArea Mode]、または、Jump PauseArea Mode を使用することにより、この継ぎ目を簡単に判別できます。(「1-4-4-6 切り 

出し条件の編集」参照。) 

 
抜き出し条件成立区間 

 
 

MARK MARK MARK 
 

元ファイルのヘッダファイルの MARK/PAUSE の更新 元ファイルのヘッダファイルに、ここで設定した抜き出し条件成

立地点を MARK 行として書き込むことができます。この機能は条件 成立区間が存在し、論理演算モードが[AND]または[OR]

のときに有効となります。 

 

<Preview> Window の[Mark List]をクリックすると、確認ダイアログが表示されます。 

クロスカーソルを細かく移動するときクリックします。 

    
    

 

<View Ch>で他のチャネルを選択して、他のチャネルの抜き出し範囲を表示することもできます。 

データ(スキャン)数/抜き出し成立範囲数 

黒く囲まれた部分が抜き出し範囲となり 

ます。 

クロスカーソルをマウスで移動してデータ 

値を読み取ることができます。 

抜き出し条件が複数行定義されている 

とき、論理演算を加味しないで Preview 

表示を行う場合は、論理演算モードで 

[SEQ]を設定してから、[Preview]をクリ 
ックします。 

Y 軸の Zoom In/Out ができます。 

論理演算モードが[AND]または[OR]のとき 

 

元データファイルの解析範囲切り出し区間(反転表示部分) 
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MARK 行の書き込み方法を選択します。 
<Renew>を選択した場合は、解析範囲に指定されている区間で既 

に存在している MARK 行を削除し、新たに条件成立地点を MARK 

行として生成します。 

<Append>を選択した場合は、削除せず、条件成立地点を MARK 

行として追加記録します。 
なお、生成される MARK 行は、開始地点か終了地点かの識別のた 

め、MARK 行にメモが付加されます。開始点のメモは BEGIN(x)、終 

了点のメモは UNTIL(x)となります。x は成立している区間の番号で、 

<Preview> Window の左から成立区間ごとに 1,2,3...の様に割り当 

てられます。 
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このページはブランクです。 
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４． 基礎的な解析操作 

前章では、波形表示画面から解析対象とする波形範囲を切り出す方法を説明しました。 ここでは、そ

の切り出された区間に対して、簡単な解析やレポート作成を行う方法について説明します。 
 

◆ 基本統計演算 

◆ データを音で聴く 

◆ ファイル変換 

◆ 波形の拡大機能 

◆ レポート出力のための手書き機能 波形切り出し後の、他のデータ解析に

ついては別冊の応用編に記載します。 
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４．１． 基本統計演算 Window 

切り出された解析区間の各チャネルの平均値、最大値、最小値、標準偏差値、実効値、最大振幅値、合計値を表形式の 

Window に表示します。この Window の内容はプリントアウトできる他、Window に表示されている統計データを、CSV 形式のファイ 

ルに出力することができます。 
 

４．１．１．操作 
統計演算値を求めたい解析対象区間を切り出します。 

メニューバーの[Analyze] -> [Statics Report...]をクリック、または、ツールバーの、 をクリックします。 
 

 

４．１．２．演算結果をファイルに保存する 
基本統計演算 Window の[Save]をクリックすると<Save format>ダイアログが表示されます。 

 

<ROW(行) Format>、<COLUMN（列） Format>では、チャネルを行に並 べ

るか、列に並べるかを選択します。ディスプレイに表示されている形式は 列に

チャネルが並んでいる形式です。形式を選択し、[OK]をクリックすると ファイル

保存ダイアログが表示されます。 保存ファイル名に、すでに存在しているファイ

ル名を指定すると追加記録 

（アペンド記録）を行います。 波形の部分部分を個別に統計解析し、後で

まとめて Excel などで解析す る場合、チャネルを行に並ぶ形式を選択する

と Excel での取扱いが簡単に なります。 ファイル保存ダイアログで[開く(O)]

をクリックすると、指定したファイル名で結 果をテキストファイル形式で記録し

ます。存在しないファイル名を指定した 場合は、新にそのファイルを生成す

るかしないか確認メッセージが表示され ます。保存されるデータのファイル形

式は、*.csv ファイルです。 



Page 53 

４． 基礎的な解析操作 
 

 

 
 

４．１．３．演算結果をプリントアウトする 

メニューバーの[File -> [Print...]をクリック、または、ツールバーの、   をクリックすると演算結果を印刷できます。印刷形式は、 
列を選択した時と同じ様式となります。 

 

 
なお、ここでプリントアウトされるときのタイトルは、メニューバーの[Option] -> [Title...]をクリックして表示されるダイアログで変更す 

ることができます。 
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４．２． 音声再生 Window 

切り出された解析区間のデータを PC のサウンドシステムを用いて、音声再生を行うことができます。 この機能は振動加速度や変

位、応力、ひずみ、回転パルスなどの音響信号（騒音など）以外のデータを音で聴くことにより信号 の性質などを把握するための

機能です。再生可能な音響信号に変換できる信号は±に振れていることが必要です。 
 

４．２．１．操作 
音で聞きたい解析対象区間を切り出します。次に、メニューバーの[Analysis] -> [Sound]をクリックします。 

 

 
<New Sampling> 初期値は収録サンプリングが表示されます。収録サンプリング周波数のままでは、データが可聴周波数から外

れている場合など、 改めて再生サンプリング周波数を設定します。収録サンプリング周波数より高いサンプリング周波数を設定す

ると音程は高くなり 同時に再生時間が短くなります。低い振動加速度などを聴く場合に設定します。逆に、収録サンプリング周

波数より低いサンプ リング周波数を設定すると音程は低くなり、同時に再生時間が長くなります。高い周波数の信号を聴く場合

に設定します。再生 サンプリング設定欄右に、シフトされるオクターブ数と再生時間を表示します。 

例えば、収録サンプリング周波数 1kHz、解析範囲 40 秒の時、再生サンプリング周波数 4kHz と設定すると、音程シフト 

2octave、再生時間 10 となります。 

 

<Repeat> チェックを付けると、カーソル区間を繰り返し再

生行います。 
 

<Auto Level> 音声データに変換するときに、音量を自動設定するかどうかの選択ができます。チェックを付けると自動的に音量を

設定し、変換 対象データの絶対値最大値を 30000 とした値に整合された後、音声データに変換されます。この場合、波形デー

タの大小にか かわらず、最大値を最大音量とします。 

 

[PLAY][STOP] 

[CONVERT]操作終了後、[PLAY]をクリックすると、音声再生を開始し、再生ポイントを示す▼マークが波形グラフ枠上部を移 

動します。音声再生中はサンプリング周波数の設定や再生チャネルの変更、WAV ファイルへの変換等を行うことはできません。 

再生中に停止する場合や、繰り返し再生設定時の再生停止を行う場合は、[STOP]をクリックします。クリックすると再生を中止 

します。 

音声再生チャネルを選択します。 

再生サンプリング周波数設定 

再生位置マーク 

音声再生を行うには最初に[CONVERT]をクリックして WAV ファイルに変 

換します。(16 ビットのまま WAV ファイルとなります。 

波形表示枠の左右に格納されているカーソル線 

を引き出して移動し再生範囲を設定することがで 

きます。 

音声再生波形 
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４．２．２．音声ファイルを保存する 

再生停止中で既に wav ファイルへの変換が終了している場合、変換した wav ファイルを保存することができます。 音声

再生 Window の[SAVE]をクリックするとファイル保存ダイアログが表示されます。ファイル名設定して保存します。 保存した 

WAV ファイルは、他の再生プログラムで再生することもできます。 
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４．３． ファイル変換 

切り出された解析区間のデータをデータファイルに変換して保存することができます。収録したデータから有効範囲を抜き出し別フ 

ァイルにしたり、別の解析プログラムや Excel などで解析するために利用できます ファイル変換形式は、テキストファイル形式、

DADiSP 形式（本プログラムで採用している形式）、MATLab 形式、RPC 形式の４ 種から選択できます。 

 

４．３．１．操作 
ファイル変換を行いたい解析対象区間を切り出します。 

メニューバーの[Set] -> [Cut Down Save...]をクリック、または、  をクリックします。 

 

 
DADiSP 形式に変換する 
ファイル形式は<DADiSP File>を選択します。[OK]をクリックすると、書き込み設定ウイザードが表示されます。 書き込むファイル名

を入力します。[Browse(B)]をクリックするとファイルを保存するフォルダパスが設定できます。 ファイルの拡張子は付ける必要は有り

ません。拡張子は自動的に、ヘッダファイルに"hdr"を付加し、データファイルには"dat"が付 加されて生成されます。 

既に同じ名前のファイルが存在した場合は、上書き確認ダイアログが表示されます。 記録したデータファイルは、本プログラム、また

は DADiSP プログラムで読み出すことができます。 
 

時間軸方向に結合したい場合、例えば午前中に収録したファイルと午後収録したファイルを結合する場合などは、<Append>に 

チェックを付けておくことで可能です。その場合、ここで設定するファイル名が午前のもの、波形表示されているファイルが午後のも 

のである必要があります。 また、その他の条件として、同じ収録チャネル並びであること。各チャネルの単位が同じであること、各チ

ャネルのスロープ値が同じ であることの３つの条件を満たしている必要があります。 

切り出された区間の開始/終了データ(スキ ャ

ン)ポイントを表示します。 

変換形式を選択します。 

すでに存在するファイルに追加する場合にチェックします。 
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テキスト形式に変換する 
① ファイル形式は<Text File>を選択します。テキ 

ストファイルは新規に作成する場合と、既に存在 

するファイルに追加する場合の２種の方法を選択 

できます。追加記録する場合は、<Append>にチェ 

ックを付けてから[OK]をクリックします。 

OK がクリックされると、書き込み設定ウイザードが 表

示されます。始めに、書き込むファイル名を入力 しま

す。[Browse(B)]をクリックするとファイルを保存 するフ

ォルダパスが設定できます。 ここで、ファイル名に任意

のテキストファイル拡張子 を入力することもできます。 

[次へ(N) >]をクリックします。 

 
 

② テキスト変換形式および桁数、項目区切り文 

字等を設定します。テキスト変換形式は、全桁指 

定<Significant Figure(V)>と小数点以下桁指定 

<Decimal  Figure (D)>の２種から選択できます。 
<Skip Number>は、時間軸方向でのテキスト変 

換時の飛び越し数です。[0]を設定した場合は、 

設定された範囲の全てのデータが変換され、[２]が 

設定された場合は、２個飛び越され（２個おき）変 

換されます。 

[次へ(N) >]をクリックします。 

 

 

 

③ 確認ダイアログが表示され[次へ(N) >] をクリッ 

クすると、変換を開始します。変換中は、下記のメ 

ッセージボックスが表示されます。 

 

 

 

 
④ 変換終了確認ダイアログ上で、 

<Display the result by>に、変換されたファイルを 

開くためのプログラムのあるフルパスを指定しておけ 

ば、[完了]をクリックしてダイアログを閉じた後、設 

定したプログラムが起動されます。 
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テキスト変換した結果のフォーマット例 
１列目は、収録ファイルの収録開始データを１としたデータ番号で、切り出されたデータ(スキャン)番号を示します。 
２列目３列目は、収録ファイルのヘッダファイルに記載されている収録開始年月日時刻から生成される実時間(２列目は秒の単 

位まで、３列目はミリ秒)を示します。ただし、収録データファイルに Pause 操作等が存在する場合は正しくない場合があります。な 

お、表示例では、Excel にて時刻表記に設定しています。 
 

No. DATE TIME ms   Ch1(kgf) Ch2(kgf) Ch3(kgf) Ch4(kgf) Ch5(kgf) Ch6(kgf) Ch7(kgf) Ch8(kgf) Ch9(kgf) 
2530 2006/7/28 15:36 386 0.897780 -1.400000 -3.410530 7.178950 0.804170 -1.241380 -6.711110 -0.444440 -6.088890 
2531 2006/7/28 15:36 388 0.924440 -0.777780 -3.452630 7.178950 0.870830 -1.682760 -6.788890 -0.266670 -5.733330 
2532 2006/7/28 15:36 390 1.106670 -0.111110 -3.452630 7.200000 0.854170 -1.958620 -6.922220 -0.029630 -5.244440 
2533 2006/7/28 15:36 392 1.266670 0.511110 -3.684210 7.115790 0.825000 -2.068960 -7.044440 0.074070 -4.666670 
2534 2006/7/28 15:36 394 1.271110 1.088890 -4.357890 7.073680 0.850000 -2.124140 -7.088890 0.059260 -4.266670 
2535 2006/7/28 15:36 396 1.173330 1.688890 -5.200000 7.094740 0.962500 -1.986210 -7.055550 0.044440 -4.288890 
2536 2006/7/28 15:36 398 1.133330 2.222220 -5.600000 7.157890 1.112500 -1.710340 -7.100000 -0.014810 -4.044440 
2537 2006/7/28 15:36 400 1.168890 2.866670 -5.515790 6.989470 1.216670 -1.406900 -7.255550 -0.088890 -3.600000 
2538 2006/7/28 15:36 402 1.244440 3.355560 -5.621050 6.547370 1.237500 -1.131030 -7.322220 -0.281480 -3.244440 
2539 2006/7/28 15:36 404 1.311110 3.711110 -6.105260 5.936840 1.250000 -0.855170 -7.322220 -0.488890 -3.244440 
2540 2006/7/28 15:36 406 1.351110 4.022220 -6.694740 5.578950 1.279170 -0.537930 -7.311110 -0.607410 -3.511110 
2541 2006/7/28 15:36 408 1.346670 4.533330 -7.178950 5.473680 1.350000 -0.013790 -7.311110 -0.725930 -3.688890 
2542 2006/7/28 15:36 410 1.373330 5.288890 -7.789470 5.389470 1.416670 0.689660 -7.322220 -0.814810 -3.822220 
2543 2006/7/28 15:36 412 1.395560 5.955550 -8.673680 5.410530 1.408330 1.393100 -7.133330 -0.888890 -4.222220 
2544 2006/7/28 15:36 414 1.386670 6.311110 -9.810530 5.431580 1.316670 2.096550 -6.966670 -1.066670 -5.022220 
2545 2006/7/28 15:36 416 1.293330 6.288890 -10.652600 5.347370 1.216670 2.620690 -7.011110 -1.333330 -5.777780 
2546 2006/7/28 15:36 418 1.186670 6.222220 -11.031600 4.757890 1.233330 3.062070 -7.200000 -1.851850 -6.200000 
2547 2006/7/28 15:36 420 1.164440 6.266670 -11.073700 3.978950 1.325000 3.489650 -7.255550 -2.251850 -6.622220 
2548 2006/7/28 15:36 422 1.213330 6.266670 -11.031600 3.389470 1.333330 3.944830 -7.011110 -2.474070 -7.088890 
2549 2006/7/28 15:36 424 1.302220 6.133330 -10.905300 3.221050 1.200000 4.496550 -6.722220 -2.459260 -7.844440 
2550 2006/7/28 15:36 426 1.337780 5.755550 -10.757900 3.326320 1.000000 5.131030 -6.611110 -2.400000 -8.355550 
2551 2006/7/28 15:36 428 1.271110 5.466670 -10.736800 3.284210 0.887500 5.710340 -6.611110 -2.518520 -8.822220 
2552 2006/7/28 15:36 430 1.133330 5.066670 -11.052600 3.200000 0.850000 6.110340 -6.555560 -2.711110 -9.555550 
2553 2006/7/28 15:36 432 1.071110 4.755560 -11.200000 3.284210 0.825000 6.413790 -6.455560 -2.755550 -10.488900 
2554 2006/7/28 15:36 434 1.111110 4.155560 -10.842100 3.600000 0.708330 6.675860 -6.377780 -2.740740 -11.022200 
2555 2006/7/28 15:36 436 1.177780 3.488890 -9.831580 3.621050 0.600000 7.089650 -6.400000 -2.725930 -11.044400 
2556 2006/7/28 15:36 438 1.204440 2.800000 -8.926320 3.347370 0.566670 7.475860 -6.455560 -2.903700 -11.244400 
2557 2006/7/28 15:36 440 1.160000 2.177780 -8.126320 3.073680 0.558330 7.724140 -6.411110 -2.933330 -11.622200 
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４．４． 虫眼鏡 Window 

切り出された解析区間のデータを X 軸方向に一時的に波形を拡大して表示する機能です。 

また、この Window では、収録時に付けられたマーク情報の表示の他に、マーク位置の修正やマークの削除や追加を行い、データ 切り出

しポイントの編集を行うこともできます。 

この機能は、画面の拡大再表示機能と異なり、任意に設定した領域を別の Window で拡大表示することができ、波形表示 

Window と連動した表示が可能です。波形表示 Window と同時表示させた状態で、波形表示 Window の領域を移動させると 

同時にこの Window も再描画されます。 
一時的拡大は、表示波形が圧縮されていない状態、すなわち 1 ピクセル当たり 1 点で描画されている場合でも、さらに拡大でき 
ます。 

 

 

 

４．４．１．操作 

波形表示 Window で解析範囲を指定し、表示データ数が整数範囲になるとツールバー上の   が有効となります。 

メニューバーの[Scale] -> [X Zoom In]をクリックするか、ツールバーの、    をクリックします。 虫眼
鏡 Window を閉じると、元の波形表示画面に戻ります。 

 

虫眼鏡 Window を印刷するときのグラフタイトルを設定するには、 

[Option] -> [Title (For printing) ...]をクリックします。この設定 

は、印刷時のみ有効で画面上では表示されません。また、いった 

ん設定すると、記憶され以後変更しない限り変更されません。 

クリックした位置にカーソル線が移動します。また、ドラッグするとカーソル線が 

追従します。キーボードの左右矢印キーを押すことでもカーソル線を移動で 

きます。カーソル値は非圧縮表示を行っているため、カーソル位置での正し 

い値を表示します。 

[Option] -> [Mark Display]にチェックを付けると、表示波形にマーク線が 

表示されます。ただし現在表示されている範囲にマークが存在しない場合 

は表示されません。 

マーク線の表示を中止する場合は、[Mark Display]をクリックしてチェックを 

はずします。 

グラフ左枠外に信号名を表示すること 

が で き ま す 。 [Option] -> [Name 

Display]をチェックします。信号名と単 

位を連結して表示します。また、チャネ 

ル番号と単位表示に戻すときは同じく 

メ ニ ュ ー バー [Option] -> [ChNo 

Display]をチェックします。 
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メニューバーの[Window] -> [Horz Tile]をクリックすると、波形表示画面と水平方向に並べて表示することができます。 

 

 

４．４．２．MARK の編集 

虫眼鏡 Window では、収録時に付けられたマーク情報の表示の他に、マーク位置の修正やマークの削除や追加が行えます。 メ

ニューバー[Option] -> [Mark List...]をクリックすると、<Mark List Edit>ダイアログが表示されます。 

 

 

Mark 番号<No.>はデータ番号<Point>の昇順で自動的に割り当てられます。後述する Mark 情報の削除あるいは追加操作を行 

うと自動更新されます。ステータス情報<Status>は、現在虫眼鏡 Window で表示されている Mark は<Visible>と表示され、また 

追加された場合は<New>と表示されます。 

切り出し範囲を左右に移動すると連動して虫眼鏡 Window の

表示が左右にスクロールします。 
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MARK MEMO の編集 
<Mark List Edit>ダイアログ上の編集したい Mark 行をダブルクリックすると<Edit the mark>ダイアログが表示されます。 

 

 

MARK の削除 

表示されているマーク線のグラフ枠外 Mark 番号位置を右クリックすると<Delete the mark>ダイアログが表示されます。[OK]をクリ 

ックすると当該 Mark が削除され、Mark 番号が詰められ自動更新されます。 
 

MARK の追加 

グラフ表示枠内を右クリックすると、<Add the mark>ダイアログが表示されます。[OK]をクリックすると虫眼鏡 Window の現在カーソ 

ル線位置に Mark を付けることができます。Mark 番号はデータ番号の昇順に振り返られ、自動更新されます。 

Mark 位置の移動は一旦マークを追加し、元のマークを削除するか、削除した後、新たなマークを追加するかのいずれかの方法に 

より行います。 

 

カーソル線 

ここにカーソルを置き、右クリックすると<Add the mark>が表示されます。 

[OK]をクリックすると、この Mark を現在カーソル線位置に追加します。 

<Memo>にメモを入力します。[OK]を ク

リックすると、当該  Mark の<Memo> 
が書き換わります。 

ここにカーソルを置き、右クリックすると<Delete the mark>が表示されま 

す。[OK]をクリックすると、この Mark を削除します。 
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MARK 位置へのジャンプ 

マーク線表示が ON 状態で現在表示されている波形範囲に、マーク線が存在する場合、ジャンプアイコンが有効となります。 アイ

コンをクリックするとアイコン方向の直前・直後にあるマーク線位置にカーソル線が移動しマーク位置データを読み出すことがで きま

す。 

 

 

 

編集されたマーク情報は、一時的に内部メモリ上で保存されています。当該ファイルを閉じるときにヘッダファイルに書き込みを行う 

か否かの確認メッセージダイアログが表示され、変更されたヘッダファイルに名前をつけてデータファイルとともにファイル生成すること 

ができます。 
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４．５． 手書き Window 

切り出された解析区間のデータを、別 Window に表示し、カーソル間の最大値・最小値や平均値などの統計値やカーソル値を 

直接書き込む機能です。 
解析範囲を指定して、メニューバー[Analyze] -> [DrawPlot]をクリック、または、         をクリックします。 

 

解析範囲を指定した波形表示画面が、SeparateWave モード(チャネルごとグラフ枠形式)の場合は、DrawPlot 手書き Window 

も、チャネルごとグラフ枠表示形式、波形表示画面が、CommonWave モード(共通グラフ形式)の場合は、DrawPlot 手書き 

Window  もグラフ枠共通表示形式の手書き Window が表示されます。 
 

SeparateWave モードからの手書き Window: 

最大 8ch まで同時に表示できます。波形表示画面に表示されていたチャネルの先頭から 8ch までを手書き Window に表示し 

ます。 
 

 
CommonWave モードからの手書き Window: 

8ch を超えるチャネルを同時表示できます。 
 

 

Window 表示形式を切り換えるには、いったん手書き Window を閉じて、波形表示画面に戻り、メニューバー[Set] -> 

[CommonWave]にチェックを付ける、またはチェックをはずしてから、再度、切り出し範囲を指定して、[Analyze] -> [DrawPlot]を 

クリックします。 
 

メインの画面の表示モードで、自動的に手書き Window のスタイルは決定されます。 

いったん、手書き Window を閉じ、再び同じ File を表示した場合、直前に書き込まれている値を自動表示されます。ただし Memo 

書き込みは除きます。 
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４．５．１．操作 
 

手書き Window の X 軸表示範囲の決定 
手書き Window の X 軸表示範囲は、メイン波形表示 Window の切り出し範囲となります。 

したがって、手書き Window の X 軸表示範囲をある値に設定したい場合は、切り出し設定でその範囲を明示的に指定する必要 

があります。(「３．１．２．切り出し開始ポイントと範囲を設定する」参照下さい。) 

 

４．５．１．１． SeparateWave モードからの手書き Window の操作 

SeparateWave モードからの手書き Window の操作と、CommonWave モードからの手書き Window の操作はほぼ同じですが、異 

なる部分についてはモードごとに操作を説明します。 
 

手書き Window が起動されると次の表示となります。 

手書き Window での操作は、画面に表示されている PopUp ツールボックスであらかじめ書き込む値を選択しておき、カーソルを表 

示し、書き込みを行う区間を指定し、実際の書き込みを行う手順となります。 
 

 

手書き Window 表示スケールとグラフタイトルの設定 
Y 軸のスケールを設定するには、 

 

表示初期値は、メインの波形表示 Window のスケールで、ダイアログでは<Auto Scale>に設定されています。スケールを設定する 

場合は、<Auto Scale>のチェックをはずし、表示スケール最大値<Max>、最小値<Min>、グリッド間隔値<Step>を入力します。 

表示されている全てのチャネルに同じスケール値を設定する場合は、<All CH>にチェックを付けます。 

 

このダイアログは、手書き Window のメニューバーの[Option] -> [Y Scale Setting]をクリックしても表示できます。このとき、画面左 

端の、下線が付けられた縦書きのチャネル名表示のチャネルのダイアログとなります。 

PopUp ツールボックス 

設定を行いたいチャネルタイトル領域で左クリックすると、<Scale Setting 

Of Y Axis>ダイアログが表示されます。 
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グラフ枠 X 軸スケール部分で左クリックすると、<X Axis Grid 

Seting>ダイアログが表示されます。 

Y 軸手書き値の表示形式を設定するには、 
 

 
初期設定は、波形表示 Window で設定された値表示形式となっています。(「２．３．３．１． Y 軸スケールデータ値表示形式の 

設定」参照。) 

Exponential format → 浮動小数点形式で有効桁を指定します。 

Fractional format → 固定小数点形式で小数点以下桁を指定します。 

Significant Format  → 固定小数点形式で全桁数を指定します。 
 

このダイアログは、手書き Window のメニューバーの[Option] -> [Y Format & Precision]をクリックしても表示できます。 
 

ここで設定された表示形式で、後述する手書きのデータ値や時間、メモシートのデータ値が記述されます。 

X 軸のスケールを設定するには、 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
ダイアログの初期値は、<Auto Scale>に設定されています。スケールを設定する場合は、<Auto Scale>のチェックをはずし、スケー 

ル表示間隔<Scale Draw Interval>とスケール値の分割書き込み間隔<Grid Line Interval>を設定します。 

<Scale Draw Interval>は、元の波形表示画面の X 軸スケールが時間に選択されている場合(メインの波形表示画面のメニュー 

バー[Option] -> [Time Display]にチェック)は秒数<SEC>を、データ(スキャン)ポイント数が選択されている場合(メインの波形表示 

画面のメニューバー[Option] -> [Point Display]にチェック)はデータ(スキャン)ポイント数<POINT>で入力します。 

チャネルタイトル領域で右クリックすると、<Y Format>ダイアログが表示され 

ます。 
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<Grid Line Interval>は、選択されたグリッドスケールの何分割ごとにスケール値表示するかを選択します。分割間隔は、1/1、1/2、 

1/5、1/10、1/20 から選択します。<Scale Draw Interval>が 10<SEC>に設定され、<Grid Line Interval>が 1/2 の場合は、20 

秒ごとにスケール値が書き込まれます。 
 

このダイアログは、手書き Window のメニューバーの[Option] -> [X Scale Setting]をクリックしても表示できます。 
 

X 軸の表示形式を設定するには、 
 

初期設定は、波形表示 Window で設定された表示形式となっています。(「２．３．４．１． X 軸スケール表示属性の設定」参 

照。) 

Exponential format → 浮動小数点形式で有効桁を指定します。 

Fractional format → 固定小数点形式で小数点以下桁を指定します。 

Significant Format → 固定小数点形式で全桁数を指定します。 

Relative time format  → 収録開始からの経過時間を指定します。 
Real time format  → 収録時刻を指定します。 

 

 

このダイアログは、手書き Window のメニューバーの[Option] -> [X Format & Precision]をクリックしても表示できます。 
 

グラフのコメントを編集・入力するには、 

 

 

グラフの初期値は、ヘッダファイルに書かれたコメントです。 

グラフ枠 X 軸スケール部分で右クリックすると、<X Format>ダイアログが表 

示されます。 

<Cmt>部をダブルクリックすると、グラフコメントの編集・入 力

ができます。 
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クリックされた状態でカーソル機能を有効として値書き込みを可能としま 

す。 

波形をクリックするとそのポイントの値 

が書き込まれます。 

クリックするとチャネル名を書き込みます。 

あらかじめ保存された書き込み値保存ファイルを(拡張子 drw)呼び出 し、

現在の表示に値をプロットします。 

クリックするとメモシートを表示します。 

  

クリックするとコメント書き込みができ ま

す。 

 
 

実際の書き込み操作例 
① PopUp ツールボックスの操作: PopUp ツールボックスであらかじめ書き込みを行う値を決めておきます。 

 

 

 

 

 

 

 

 
 

   
 

 

 

平均値と区間の時間の書き込み例 左右カーソル値の書き込み例 

クリックすると、書き込み値を選択す る

ダイアログを表示します。 

チェックを付けた値を自動的に書き込みます。 

①  Max Value  → 区間の最大値 

②  Min Value  → 区間の最小値 

③ Def. of Max & Min  → 区間内の最大  - 最小値 

④  Mean Value  → 区間の平均値 

⑤  Def.Time Value  → 区間の時間（sec） 

⑥  First Cursor Value  → 左側カーソル位置のデータ値 

⑦  Second Cursor Value  → 右側カーソル値のデータ値 

⑧  Def. of Cursor Value  → 左右カーソル値の差分値 

⑨ Slope Value → 左右カーソル値の傾斜値 左の例では、左側と右

側のそれぞれのカーソルの位置のデータ値を書き込むこととなります。 

 

各項目の横の色変更ボタンをクリックすると色の設定ダイアログが表示さ

れます。上記①～⑨の項目で背景色を、TextColor の項目で文字の

色を変更できます。 

最大値と最小値の書き込み例 

左右カーソル値の差分値の書き込み例 左右カーソル値の傾斜値の書き込み例(イタリック表記) 

最大値  - 最小値の書き込み例 



Page 68 

４． 基礎的な解析操作 
 

 

 
 

② 書き込みデータ値を選択する<Statistic Data Selecting>ダイアログで選択された値を書き込むには、波形表示の対象区間 

を２本のカーソルで指定します。まず、対象区間の左端に 1 本目のカーソルを出します。 
 

1st カーソル(左カーソル)の位置の微調整は、キーボードの左右矢印キー[←] [→]で行います。 

[Ctrl]を押しながら左右矢印キーを押すと、大きくカーソルが移動します。 

 

③ 対象開始区間が決定したら、次に、対象区間の右端に２本目のカーソルを出します。 

 

2nd カーソル(右カーソル)の位置の微調整は、キーボードの[Shift]を押しながら左右矢印キー[←] [→]で行います。 [Shift]を押

しながら[Ctrl]と左右矢印キーを押すと、大きくカーソルが移動します。 

 

④ 各カーソルの、正確な位置とデータを見るためには、手書き Window のメニューバー[Option] -> [CursorPosView]をクリックし 

ます。画面右に、各チャネルの左右カーソルの位置とデータを表示します。 
 

⑤ ②と③のカーソル操作で、位置の微調整を行うことができます。 

対象区間の左端の波形位置 で

マウスを左クリックすると、1 本 
目のカーソルが表示されます。 

カーソル操作を有効にするには必ず、このボタ 

ンがクリックされ押し込まれた状態であることを 

確認して下さい。 

対象区間の右端の波形位置 で

マウスを左クリックすると、2 本 
目のカーソルが表示されます。 
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この範囲以外の場所で、マウス右クリック す

ると、カーソル線が元の位置に復活しま 
す。 

書き込み後消えたカーソル位置 

この範囲で書き込みたいチャネル表 

示枠にマウスカーソルを置き、左クリ 

ックを行います。 

 
 

⑥ <Statistic Data Selecting>ダイアログで選択された値を書き込むために、カーソルで囲まれた区間の中で該当チャネル表示 

枠にマウスカーソルを置き、そこで、マウス左クリックを行います。 
 

 
⑦ 先に行われた選択にしたがって値が自動的に書き込まれます。 

 

 
事前に PopUp ツールボックスの[ALL]がクリックされていれば、すべてのチャネルの対象区間のデータを同時に書き込みます。 書き

込みが行われたときに、他のチャネルの同位置のデータを追加で書き込みたい場合は、次のように操作します。 

 

追加で書き込みを行いたいチャネル位置で、マウス左クリックする 

と、そのチャネルの書き込みが追加できます。 
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⑧ 書き込まれた値は、チャネル表示枠内であれば、カーソルでドラッグ&ドロップして、表示位置を移動することができます。 

 

 

 

 

 

 

 
 

⑨ 同様の操作を繰り返して、別の位置に書き込むことができます。 

 

 

⑩ 波形の特定の位置の値を表示するには、 
 

⑪ チャネル名を表示するには、PopUp ツールボックスの[SIG NAME]をクリックします。 

 

特定値の書きこみ後、カーソルによる値書き 

込みを再度有効にするために、必ずここをク 

リックし下さい。 

ここをクリックした状態で、書 

き込みを行いたいポイントで 

左クリックを行うと値が表示さ 

れます。 

書

き込みを再度有効にするために、必ずここ を

クリックし下さい。 

チャネル名は数値書き込みと同様にチャネル表示枠内でド ラ

ッグ&ドロップで移動できます。 
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⑫ 波形表示に対するコメントを書き込みたいときは、PopUp ツールボックスの[あ]をクリックします。 

<Comment Setting>ダイアログが表示され、波形画面に表示するコメント入力ができます。 
 

[OK]をクリックすると、入力されたコメントを画面に書きこみます。コメント書き込み後、ドラッグ&ドロップで任意の位置に移動する こと

ができます。 

 
 

⑬ PopUp ツールボックスの[MEMO]をクリックすると、書き込みが行われた位置のデータが表形式(メモシート)で表示されます。 メモシ

ートは 1ch/行 で構成され、現在表示されている範囲で書き込んだ値が表示されます。解析対象ファイルが同じであれば、 いったん、

手書き Window  を閉じても保持され、次に手書き Window を開き、別の書き込みを行うと、行が追加されます。 

シートに表示され る 内容は、 Max.Value( 最大値)、 Max.Pos （ sec ） ( 最大値位置、 単位は 秒)、 Min.Value( 最小値)、 

Min.Pos(sec)(最小値位置、単位は sec)、Dif.MaxMin(最大値と最小値の差)、MeanValue(平均値)、Dif.Cur.Time（sec）(カー 

ソル区間の時間)、L.Cur.Value(左カーソル位置の値)、R.Cur.Value(右カーソル位置の値)、Dif.Cur.Value(左-右カーソル位置 

データの差分)、Dif.Cur.Slope(左-右カーソル位置データの勾配)、CursorTime(sec)(左カーソル位置、単位は秒)、File.Name(フ 
ァイル名)です。 

 

コメント書きこみ後、カーソルによる値書き込 

ク

し下さい。 

ここで書き込みたい位置を選択します。Auto では、画面の自由な位置 

に、各数字では該当するチャネル番号枠内となります。 

しま

す。 

現在のデータファイル名を表示します。 

セルをダブルクリックすると、<Memo>を入力でき ま

す。 

クリックすると、リストの内容を CSV ファイルに保存できます。 

クリックすると、リストの内容がすべてクリアされます。 個別の行を選択

し、Delete キーを押して削除することもできます。削 除された値は、グ

ラフ表示からも削除されます。 
グラフにプロットされた数値をファイルに保存 

することができ、後で手書き Window に読み 

込むことができます。 

メモシート表示を閉じ、手書き Window に戻 

ります。 

ファイルの日付と書き込み範囲の個数 
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書き込まれた値をクリアする 
① クリアする書き込み値の周辺のチャネル表示枠内で、右クリックします。 

 

値書き込み位置(数値が書かれた黄色のボックス)にカーソルを置き、右クリックした場合は、下記手順②から⑤に直接飛びます。 

メモシートから、表示項目を削除し、該当の書き込みをグラフから消去することもできます。 
 

② 値を削除してよいか確認のメッセージボックスが表示されます。 

 

③ [はい(Y)]をクリックすると、書き込まれた値の表示を削除し、元のデータ書き込み用のカーソル線が表示されます。 

 
 

 

④ 右クリックをして、右のカーソルを消去します。 

 

⑤ もう一度、右クリックすると左のカーソルも消去されます。 

 

このエリア内で右クリック 

このとき、 カーソル区間内にマウスカーソルを置 

き、左クリックすると、値の再書き込みが有効とな 

ります。 
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４．５．１．２． CommonWave モードからの手書き Window の操作 

CommonWave モードからの手書き Window が起動されると次の表示となります。 

この時、Y 軸スケールはメインの波形表示 Window のスケール、X 軸スケールは、切り出された範囲となります。 
 

PopUp ツールボックスの内容が、SeparateWave モードからの手書き Window と少し異なります。 

 

クリックされた状態でカーソル機能を有効として値書き 

込みを可能とします。 

クリックすると、書き込み値を選択す る

ダイアログを表示します。 

クリックされた状態で、全チャネル同時に書き込みます。 

ファイルに保存された値を書き込みます。 

クリックするとメモシートを表示します。 

クリックするとコメント書き込みができ ま

す。 

チェックを付けた値を自動的に書き込みます。 

①  Max Value  → 区間の最大値 

②  Min Value  → 区間の最小値 

③ Def. of Max & Min  → 区間内の最大  - 最小値 

④  Mean Value  → 区間の平均値 

⑤  Def.Time Value  → 区間の時間（sec） 

⑥  First Cursor Value  → 左側カーソル位置のデータ値 

⑦  Second Cursor Value  → 右側カーソル値のデータ値 

⑧  Def. of Cursor Value  → 左右カーソル値の差分値 

⑨ Slope Value → 左右カーソル値の傾斜値 左の例では、左側と右側のそれぞれのカー

ソルの位置のデータ値を書き込むこととなります。 

 

各項目の横の色変更ボタンをクリックすると色の設定ダイアログが表示されます。上記①～

⑨の項目で背景色を、TextColor の項目で文字の色を変更できます。 
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CommonWave モード手書き Window での操作 
個々の操作の詳細については、SeparateWave モードの手書き Window の操作を参照して下さい。 

 

 

データの表示形式の設定は、 

手書き Window のメニューバー[Option] -> [X Format & Precision]、[Option] -> [Y Format & Precision]で行います。 

 

 

チャネル情報リストの表示 

画面右側のチャネル情報リストは、CommonWave モードの手書き Window で、チャネルの表示 On/Off、各チャネルの描き出しグ 

リッド位置設定やグリッド幅の設定を行うためのリストです。 
このリストの内容を変更することで、Y 軸の表示形式を変更することができます。 

 

手書き Window のメニューバー[Tool] -> [ChInfo]をクリックするか、ツールバーの、 をクリックします。 

デフォルトでは、クリックされた状態になっています。 

Re-Formation: チャネルの描き出し位置を再配置します。 

Overlay: カレントチャネルの描き出し位置にすべてのチャネルを重ね描きします。 

ダブルクリックすると<Cmt>の編集と入力ができます。 

チャネルタイトルバーには、チャネル名(グリッド幅) 左

カーソル値の３つが表示されます。 

この位置でダブルクリックすると、<X Axis Grid Setting>ダイアログが表示さ れ、

X 軸スケールの設定ができます。 
または、手書き Window のメニューバー[Option] -> [X Grid Setting]をクリッ 
クします。 

左カーソルの X 軸位置が表示されます。および左右カーソル間の幅を 

表示します。 
メインの波形表示画面のメニューバー[Option] -> [Time Display]がチ 
ェックされている場合は時間、 メインの波形表示画面のメニューバー

[Option] -> [Point Display]がチ ェックされている場合はデータ(スキャン)

ポイント数となります。 

カレントチャネルのスケールが表示されます。 カレントチ

ャネルは、チャネルタイトルバーが反転表示と 
なり、右側のチャネルリストもブルーのセルとなります。 

ここをダブルクリックすると、Y 軸グリッド数の 変

更ができます。 

グリッド番号が表示されます。 
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コピー先のセルの値が書き換わり 

ます。 

ここをクリックすると、チャネル情報リストの表示の On/Off ができ 

ます。 

ファイルの情報が表示されます。 

現 在 表 示 さ れ て い る 左 (Cursor1)/ 右 

(Cursor2)カーソルの値を表示します。 Grid No.には各チャネルの描き出しグリッド 

位置が指定できます。 

各チャネルのグリッド幅設定ガイドのた 

め、波形表示区間の最大値と最小値 

を表示します。 

<Grid 

 

チェックをはずすと、表示 Off となります。 

チャネル情報リスト 

境界線上にカーソルを置きマウスをド ラ

ッグすると表示範囲の横方向への拡 
大・縮小ができます。 

チャネル情報リストが画面の右側に表示されます。 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

Width>のセルに値を入力すると Y ールが

変更できます。 

 

DispOffset は、グラフ描き出し位置の値を入 

力できます。 

 

 

 

 

 
 

<Grid Width>の値は、他のセルにコピー&ペーストできます。 

コピー元のセルにカーソルを置き 

右クリック、[Copy(C)]をクリックし 

ます。 

コピー先のセル(複数可)を[Ctrl] 

または[Shift]+左クリックで選択、 

[Paste(P)]をクリックします。 
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チャネル情報リストの表示ソート 

チャネル情報リストの<No.>セルをクリックするごとに、「表示番号順」→「表示 On→Off 順」→「表示番号順」→...にチャネル情報 

行の並び替えが行われます。 
この機能は、収録チャネルが多く、表示するチャネルが飛び飛びに設定されたときに便利です。 

 

 

チャネル表示を表示 Off から表示 On にすると、元のグラフ位置に再描画します。 チャネル情報

リストの各タイトルセルをクリックすることで、表示昇順・降順のリスト表示ができます。 

<Grid No.>をダブルクリックして数字を入力、または、波形画面のチャネルタイトルラベルをドラ 

ッグして上下に移動することで、チャネル情報リスト内のグリッド番号を変更することができま 

す。 

 

 

 

 

 

 

 
 

チャネルタイトルラベルとグラフ線色の変更 
チャネルタイトルラベルとグラフ線色を変更するには、<Color>のセルにあるカラーバーをダブルクリックします。 

ここをクリック 

ダブルクリックして、カラーパレット を

表示します。 
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Y 軸スケール情報の保存 

CommonWave 手書き Window では、現在表示されている Y 軸スケール情報(Y 軸描き出し位置、グリッドスケール、表示オフセッ 

ト、グラフ色)にファイル名を付けて(拡張子 scl)保存・読み出しすることができます。 
Y 軸スケールにファイル名を付けて保存するには、手書き Window のメニューバー、[File] -> [Save Scale]をクリックします。 

保存された Y 軸スケール情報を適用し表示変更を行うには、手書き Window のメニューバー、[File] -> [Load Scale]をクリックし 

ます。 
 

４．５．２． 波形グラフのプリントアウト 
表示されている波形のプリントアウト 

メニューバーの[File] -> [Print...]をクリックすると、現在表示されている波形グラフをプリントアウトすることができます。 プリンタの設

定は、[Print Setup...]で行います。また、[Print Preview]では、プリントアウトイメージをプレビューすることができます。 
  

 

CommonWave からの手書き Window プリントアウト例 

 

CommonWave 波形表示からの手書き Window では、プリントアウト時のグラフ線の太さの選択ができます。 

[Option] -> [Print Line Size]をクリックして線の太さを 

選択します。 
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４．５．３． 手書き Window 範囲の移動 
メインの波形表示 Window の切り出し区間を移動することで、手書き Window の表示範囲も連動して移動させることができます。 

 

手書き Window のメニューバーの[Window] -> [Horz Tile]または[Vert Tile]をクリックして、波形表示 Window を同時表示します。 

波形表示 Window の切り出し区間をマウスで移動すると、連動して Y 軸スケールを保持しながら手書き Window の表示区間も 

移動します。 
 

 

４．５．４． プロットされた値の保存と値の書き込み 

手書き Window に書き込まれた値は、同じファイルが再度オープンされ、手書き Window 操作が行われた場合でも、該当位置に 

自動的にプロットされます。 
また、PopUp ツールボックスの[MEMO]の[POS_SAVE]をクリック(「４．５．１．１． SeparatｒeWave モードからの手書き Window の 

操作」参照)すると、現在のメモシートに表示された内容をプロットデータファイル(拡張子 drw)として保存することができます。 この

ファイルを、PopUp ツールボックスの[FILE]をクリックして呼び出すことで、現在の手書き Window 表示範囲に保存されたデータ の

プロット位置が該当しているデータのプロットが行われます。 

 

別途記述するスクリプト演算により求められた結果を、プロットデータファイルとして保存し、手書き Window の波形表示にプロット 

することもできます。 

切り出し範囲をマウスで移動 
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５． ファイル形式 

ここでは、PcWaveForm で扱うことのできるファイル形式について説明します。 

 

WFScript で扱うファイル形式については、別冊の Script 編に記載します。 
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５．１． 基本のファイル形式 

PcWaveForm で読み込むことのできる、基本のデータファイルは当社レコーダで収録されたデータファイル(あるいは互換性のあるデ 

ータファイル)となります。このファイルは、収録条件などが記録されたテキストベースのヘッダファイルとバイナリデータファイルがペアで 

構成されたデータファイルです。 
 

５．１．１． ヘッダファイル形式 

データファイルとペアで作成されるテキストファイルで拡張子は hdr または*a*です。また、このファイルは DADiSP のヘッダファイルの 

書式に準じキーワードとパラメータの組み合わせで構成されます。 
 

例 
DATASET Test_004_HDR 
VERSION 1 

SERIES CH1,CH2,CH3,CH4,CH5,CH6,CH7,CH8,CH9,CH10,CH11,CH12,CH13,CH14,CH15,CH16 

DATE 07-25-2006 
TIME 12:06:36 

RATE 500 

VERT_UNITS uST,uST,uST,uST,uST,uST,uST,V,uST,uST,uST,uST,uST,uST,uST,uST 

HORZ_UNITS Sec 
NUM_SERIES 16 

STORAGE_MODE INTERLACED 
FILE_TYPE INTEGER 
SLOPE 
8.000000e-02,8.000000e-02,8.000000e-02,8.000000e-02,8.000000e-02,8.000000e-02,8.000000e-02,4.000000e-04,8.000000e-02,8.000000e-02,8.000000e-02,8.00000 

0e-02,8.000000e-02,8.000000e-02,8.000000e-02,8.000000e-02 
X_OFFSET 0 
Y_OFFSET 

-2.800000e+00,-3.520000e+00,3.200000e+00,3.840000e+00,-3.120000e+00,-5.120000e+00,9.600000e-01,0.000000e+00,4.000000e-01,4.000000e-01,-1.840000e+ 
00,-2.880000e+00,-5.200000e+00,-4.240000e+00,-3.840000e+00,0.000000e+00 
NUM_SAMPS 4981 

TRG_POINT 0 
DATA 
DEVICE DR-600 

FILENAME test_004.dat 

CLOCK INTERNAL 
CH1 AR-60ST8K_101,RANGE=2000uST,FILTER=PASS 
CH2 AR-60ST8K_102,RANGE=2000uST,FILTER=PASS 

CH3 AR-60ST8K_103,RANGE=2000uST,FILTER=PASS 
CH4 AR-60ST8K_104,RANGE=2000uST,FILTER=PASS 
CH5 AR-60ST8K_105,RANGE=2000uST,FILTER=PASS 

CH6 AR-60ST8K_106,RANGE=2000uST,FILTER=PASS 
CH7 AR-60ST8K_107,RANGE=2000uST,FILTER=PASS 
CH8 AR-60ST8K_108,RANGE=10V,FILTER=PASS 

CH9 AR-60ST8K_201,RANGE=2000uST,FILTER=PASS 
CH10 AR-60ST8K_202,RANGE=2000uST,FILTER=PASS 
CH11 AR-60ST8K_203,RANGE=2000uST,FILTER=PASS 

CH12 AR-60ST8K_204,RANGE=2000uST,FILTER=PASS 
CH13 AR-60ST8K_205,RANGE=2000uST,FILTER=PASS 

CH14 AR-60ST8K_206,RANGE=2000uST,FILTER=PASS 
CH15 AR-60ST8K_207,RANGE=2000uST,FILTER=PASS 
CH16 AR-60ST8K_208,RANGE=2000uST,FILTER=PASS 

MARK 1942,12:06:40 
MARK 2847,12:06:42 

MARK 3922,12:06:44 

END4981 
 

DATASET: データの名前です。ファイル名の拡張子の"."(ピリオド)を"_"(アンダーライン）に変えたものです。 

VERSION 1: データのバージョンナンバーです。１に固定されています。 

SERIES: 個々の収録チャンネルの名前をカンマで区切って表示します。 

DATE: 収録開始日付 

TIME: 収録開始時刻 
RATE: サンプリング周波数を Hz で表します。外部サンプル時は１に設定されます。 

VERT_UNITS:   チャンネル毎の単位をカンマで区切って記述します。 

HORZ_UNITS: 時間軸の単位を示します。Sec に固定です。 

NUM_SERIES: 収録チャンネル数を示します。 

STORAGE_MODE: INTERLACED に固定されています。 

FILE_TYPE: INTEGER または FLOAT。 

SLOPE: 物理量変換のための係数。 

Y_OFFSET: 物理量変換のためのオフセット。 

X_OFFSET: 0 の場合は、プリトリガデータがないことを示します。 

NUM_SAMPS: 各チャネルの収録データ数 

DATA: この文以下は各レコーダ固有の情報です。 

DEVICE: 収録装置名が書かれます。 
FILENAME: このアトリビュートファイルとペアになるデータファイルの名前です。 
CLOCK: EXTERNAL は外部サンプル、INTERNAL は内部サンプルにて収録が行われたことを示します。 

COMMENT: 収録設定プログラムで Memo 欄に入力された内容が表示されます。 

MARK: MARK 位置のデータ(スキャン)ポイント数。 

PAUSE: 収録一時停止再開されたデータ(スキャン)ポイント数および時刻。 

END: 各チャネルの収録データ(スキャン)数（レコードポインタ） 
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５．１．２． データファイル形式 

データファイルはバイナリーファイルで、データレコードの集まりで構成されています。データレコードは１サンプル点あたりのデータ群で 

以下の構造です。ファイルの拡張子は、dat または*d*です。 
 

例: 1CH, 3CH, 7CH の S/C を有効にして収録した場合（FILE TYPE: INTEGER の場合） 

 

 
 

LOW 
 

8 bits 

 

HIGH 
 

8 bits 

 

LOW 
 

8 bits 

 

HIGH 
 

8 bits 

 

LOW 
 

8 bits 

 

HIGH 
 

8 bits 

 

LOW 
 

8 bits 

 

HIGH 
 

8 bits 

 

LOW 
 

8 bits 

 

HIGH 
 

8 bits 

 

LOW 
 

8 bits 

 

HIGH 
 

8 bits 

 

1 CH 

 

3 CH 

 

7 CH 

 

1 CH 

 

3 CH 

 

7 CH 

 

1st record 
(1/Sampling Frequency) seconds 

 

2nd record 

 

 

 
レコードが、収録データ(スキャン)数だけ集まったファイルになります。 各チャネルのデータは、一つの整数値が下位バイト、上位バイ

トの順番（リトルエンディアン）で並んでいます。※ 収録データをアンプ単位に変換する場合は、ヘッダファイルに記録されているスロ

ープと収録データを掛け算した結果にオフセット量 を加算して求まります。 

スロープ値はヘッダファイルの SLOPE 行に、オフセット量は Y_OFFSET 行に記載されています。 

 

※FILE_TYPE: FLOAT の場合は、各チャネルのデータは、符号部（1 ビット）、指数部（8 ビット）、仮数部（23 ビット）が 4 バイトに 

分割され並びます。 
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このページはブランクです。 
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このページはブランクです。 
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